## Contents

### Chapter 1 Library

1.1 Introduction.......................................................................................................................... 5
  1.1.1 Overview........................................................................................................................ 5
  1.1.2 Data types..................................................................................................................... 5
  1.1.3 API definition............................................................................................................... 5
  1.1.4 Supported compilers.................................................................................................... 6
  1.1.5 Library configuration.................................................................................................... 6
  1.1.6 Special issues............................................................................................................... 6
1.2 Library integration into project (MCUXpresso IDE) ............................................................ 6
1.3 Library integration into project (Keil µVision) ..................................................................... 10
1.4 Library integration into project (IAR Embedded Workbench) ............................................ 18

### Chapter 2 Algorithms in detail

2.1 GMCLIB_Clark.................................................................................................................... 24
  2.1.1 Available versions........................................................................................................ 24
  2.1.2 Declaration.................................................................................................................. 24
  2.1.3 Function use.............................................................................................................. 24
2.2 GMCLIB_ClarkInv............................................................................................................. 25
  2.2.1 Available versions........................................................................................................ 25
  2.2.2 Declaration................................................................................................................ 25
  2.2.3 Function use.............................................................................................................. 25
2.3 GMCLIB_Park.................................................................................................................... 26
  2.3.1 Available versions........................................................................................................ 26
  2.3.2 Declaration................................................................................................................ 26
  2.3.3 Function use.............................................................................................................. 27
2.4 GMCLIB_ParkInv............................................................................................................... 27
  2.4.1 Available versions........................................................................................................ 27
  2.4.2 Declaration................................................................................................................ 28
  2.4.3 Function use.............................................................................................................. 28
2.5 GMCLIB_DecouplingPMSM............................................................................................ 29
  2.5.1 Available versions........................................................................................................ 30
  2.5.2 GMCLIB_DECOPMSM_T_A32 type description............................................................ 31
  2.5.3 Declaration................................................................................................................ 31
  2.5.4 Function use.............................................................................................................. 31
2.6 GMCLIB_DTCmplut1D....................................................................................................... 32
  2.6.1 Available versions........................................................................................................ 34
  2.6.2 GMCLIB_DTCMLUT1D_T_F16 type description............................................................ 35
  2.6.3 Declaration................................................................................................................ 35
  2.6.4 Function use.............................................................................................................. 35
2.7 GMCLIB_ElimDcBusRipFOC............................................................................................. 36
  2.7.1 Available versions........................................................................................................ 38
  2.7.2 Declaration................................................................................................................ 38
  2.7.3 Function use.............................................................................................................. 39
2.8 GMCLIB_ElimDcBusRip..................................................................................................... 39
  2.8.1 Available versions........................................................................................................ 41
  2.8.2 Declaration................................................................................................................ 42
  2.8.3 Function use.............................................................................................................. 42
2.9 GMCLIB_SVMStdShifted................................................................................................... 43
  2.9.1 Available versions........................................................................................................ 46
    2.9.1.1 GMCLIB_SVMSTDSHIFTED_T_F16 type description..................................................... 47
Appendix A Library types

A.1 bool_t ........................................................................................................................................ 75
A.2 uint8_t ...................................................................................................................................... 75
A.3 uint16_t .................................................................................................................................... 76
A.4 uint32_t .................................................................................................................................... 77
A.5 int8_t ........................................................................................................................................ 77
A.6 int16_t ...................................................................................................................................... 78
A.7 int32_t ...................................................................................................................................... 78
A.8 frac8_t ...................................................................................................................................... 79
A.9 frac16_t .................................................................................................................................... 80
A.10 frac32_t .................................................................................................................................. 80
A.11 acc16_t .................................................................................................................................... 81
A.12 acc32_t .................................................................................................................................... 82
A.13 float_t ...................................................................................................................................... 82
A.14 GMCLIB_3COOR_T_F16.......................................................................................................... 85
A.15 GMCLIB_3COOR_T_FLT ........................................................................................................... 85
A.16 GMCLIB_2COOR_AB_T_F16.................................................................................................... 86
A.17 GMCLIB_2COOR_AB_T_F32.................................................................................................... 86
A.18 GMCLIB_2COOR_ALBE_T_F16................................................................................................ 87
A.19 GMCLIB_2COOR_ALBE_T_FLT ................................................................................................ 87
A.20 GMCLIB_2COOR_DQ_T_F16.................................................................................................... 87
A.21 GMCLIB_2COOR_DQ_T_F32.................................................................................................... 88
A.22 GMCLIB_2COOR_DQ_T_FLT................................................................. 88
A.23 GMCLIB_2COOR_SINCOS_T_F16...................................................... 88
A.24 GMCLIB_2COOR_SINCOS_T_FLT...................................................... 89
A.25 FALSE.............................................................................................. 89
A.26 TRUE............................................................................................... 90
A.27 FRAC8.............................................................................................. 90
A.28 FRAC16........................................................................................... 90
A.29 FRAC32........................................................................................... 91
A.30 ACC16............................................................................................. 91
A.31 ACC32............................................................................................. 91
Chapter 1
Library

1.1 Introduction

1.1.1 Overview
This user's guide describes the General Motor Control Library (GMCLIB) for the family of ARM Cortex M7 core-based microcontrollers. This library contains optimized functions.

1.1.2 Data types
GMCLIB supports several data types: (un)signed integer, fractional, and accumulator. The integer data types are useful for general-purpose computation; they are familiar to the MPU and MCU programmers. The fractional data types enable powerful numeric and digital-signal-processing algorithms to be implemented. The accumulator data type is a combination of both; that means it has the integer and fractional portions.

The following list shows the integer types defined in the libraries:

- **Unsigned 16-bit integer**—<0 ; 65535> with the minimum resolution of 1
- **Signed 16-bit integer**—<-32768 ; 32767> with the minimum resolution of 1
- **Unsigned 32-bit integer**—<0 ; 4294967295> with the minimum resolution of 1
- **Signed 32-bit integer**—<-2147483648 ; 2147483647> with the minimum resolution of 1

The following list shows the fractional types defined in the libraries:

- **Fixed-point 16-bit fractional**—<-1 ; 1 - 2\(^{-15}\)> with the minimum resolution of 2\(^{-15}\)
- **Fixed-point 32-bit fractional**—<-1 ; 1 - 2\(^{-31}\)> with the minimum resolution of 2\(^{-31}\)

The following list shows the accumulator types defined in the libraries:

- **Fixed-point 16-bit accumulator**—<-256.0 ; 256.0 - 2\(^{-7}\)> with the minimum resolution of 2\(^{-7}\)
- **Fixed-point 32-bit accumulator**—<-65536.0 ; 65536.0 - 2\(^{-15}\)> with the minimum resolution of 2\(^{-15}\)

1.1.3 API definition
GMCLIB uses the types mentioned in the previous section. To enable simple usage of the algorithms, their names use set prefixes and postfixes to distinguish the functions' versions. See the following example:

```
f32Result = MLIB_Mac_F32lss(f32Accum, f16Mult1, f16Mult2);
```

where the function is compiled from four parts:

- **MLIB**—this is the library prefix
- **Mac**—the function name—Multiply-Accumulate
- **F32**—the function output type
- **lss**—the types of the function inputs; if all the inputs have the same type as the output, the inputs are not marked

The input and output types are described in the following table:
Table 1. Input/output types

<table>
<thead>
<tr>
<th>Type</th>
<th>Output</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>frac16_t</td>
<td>F16</td>
<td>s</td>
</tr>
<tr>
<td>frac32_t</td>
<td>F32</td>
<td>l</td>
</tr>
<tr>
<td>acc32_t</td>
<td>A32</td>
<td>a</td>
</tr>
</tbody>
</table>

1.1.4 Supported compilers

GMCLIB for the ARM Cortex M7 core is written in C language or assembly language with C-callable interface depending on the specific function. The library is built and tested using the following compilers:

- MCUXpresso IDE
- IAR Embedded Workbench
- Keil µVision

For the MCUXpresso IDE, the library is delivered in the gmclib.a file.
For the Kinetis Design Studio, the library is delivered in the gmclib.a file.
For the IAR Embedded Workbench, the library is delivered in the gmclib.a file.
For the Keil µVision, the library is delivered in the gmclib.lib file.

The interfaces to the algorithms included in this library are combined into a single public interface include file, gmclib.h. This is done to lower the number of files required to be included in your application.

1.1.5 Library configuration

GMCLIB for the ARM Cortex M7 core is written in C language or assembly language with C-callable interface depending on the specific function. Some functions from this library are inline type, which are compiled together with project using this library. The optimization level for inline function is usually defined by the specific compiler setting. It can cause an issue especially when high optimization level is set. Therefore the optimization level for all inline assembly written functions is defined by compiler pragmas using macros. The configuration header file RTCESL_cfg.h is located in: specific library folder\MLIB\Include. The optimization level can be changed by modifying the macro value for specific compiler. In case of any change the library functionality is not guaranteed.

1.1.6 Special issues

1. The equations describing the algorithms are symbolic. If there is positive 1, the number is the closest number to 1 that the resolution of the used fractional type allows. If there are maximum or minimum values mentioned, check the range allowed by the type of the particular function version.

2. The library functions that round the result (the API contains Rnd) round to nearest (half up).

3. This RTCESL requires the DSP extension for some saturation functions. If the core does not support the DSP extension feature the assembler code of the RTCESL will not be buildable. For example the core1 of the LPC55s69 has no DSP extension.

1.2 Library integration into project (MCUXpresso IDE)

This section provides a step-by-step guide on how to quickly and easily include GMCLIB into any MCUXpresso SDK example or new SDK project using MCUXpresso IDE. The SDK based project uses RTCESL from SDK package.
High-speed functions execution support

Some RT (or other) platforms contain high-speed functions execution support by relocating all functions from the default Flash memory location to the RAM location for much faster code access. The feature is important especially for devices with a slow Flash interface. This section shows how to turn the RAM optimization feature support on and off.

1. In the MCUXpresso SDK project name node or on the left-hand side, click Properties or select Project > Properties from the menu. A project properties dialog appears.

2. Expand the C/C++ Build node and select Settings. See Figure 1.

3. On the right-hand side, under the MCU C Compiler node, click the Preprocessor node. See Figure 1.

4. On the right-hand side of the dialog, click the Add... icon located next to the Defined symbols (-D) title.

5. In the dialog that appears (see Figure 2), type the following:

   - **RAM_RELOCATION** — to turn the RAM optimization feature support on

   If the define is defined, all RTCEL functions are put to the RAM.

6. Click OK in the dialog.

7. Click OK in the main dialog.

The RAM_RELOCATION macro places the `__RAMFUNC(RAM)` attribute in front of each function declaration.
Adding RTCESL component to project

The MCUXpresso SDK package is necessary to add any example or new project and RTCESL component. In case the package has not been downloaded go to mcuxpresso.nxp.com, build the final MCUXpresso SDK package for required board and download it.

After package is downloaded, open the MCUXpresso IDE and drag&drop the SDK package in zip format to the Installed SDK window of the MCUXpresso IDE. After SDK package is dropped the message accepting window appears as can be show in following figure.

![Figure 3. MCUXpresso IDE - importing the SDK package to MCUXpresso IDE](image)

Click OK to confirm the SDK package import. Find the Quickstart panel in left bottom part of the MCUXpresso IDE and click New project... item or Import SDK example(s)... to add rtcesl component to the project.
Then select your board, and click Next button.

Find the Middleware tab in the Components part of the window and click on the checkbox to be the rtcesl component ticked. Last step is to click the Finish button and wait for project creating with all RTCESL libraries and include paths.
Type the #include syntax into the code where you want to call the library functions. In the left-hand dialog, open the required .c file. After the file opens, include the following lines into the #include section:

```
#include "mlib.h"
#include "gflib.h"
#include "gmclib.h"
```

When you click the Build icon (hammer), the project is compiled without errors.

### 1.3 Library integration into project (Keil µVision)

This section provides a step-by-step guide on how to quickly and easily include GMCLIB into an empty project or any MCUXpresso SDK example or demo application projects using Keil µVision. This example uses the default installation path (C:\NXP\RTCESL\CM7_RTCESL_4.7_KEIL). If you have a different installation path, use that path instead. If any MCUXpresso SDK project is intended to use (for example hello_world project) go to Linking the files into the project chapter otherwise read next chapter.

**NXP pack installation for new project (without MCUXpresso SDK)**

This example uses the NXP MKV58F1M0xxx22 part, and the default installation path (C:\NXP\RTCESL\CM7_RTCESL_4.7_KEIL) is supposed. If the compiler has never been used to create any NXP MCU-based projects before, check whether the NXP MCU pack for the particular device is installed. Follow these steps:

1. Launch Keil µVision.
2. In the main menu, go to Project > Manage > Pack Installer….
3. In the left-hand dialog (under the Devices tab), expand the All Devices > Freescale (NXP) node.
4. Look for a line called "KVxx Series" and click it.
5. In the right-hand dialog (under the Packs tab), expand the Device Specific node.
6. Look for a node called "Keil::Kinetis_KVxx_DFP." If there are the Install or Update options, click the button to install/update the package. See Figure 7.

7. When installed, the button has the "Up to date" title. Now close the Pack Installer.

![Figure 7. Pack Installer](image)

New project (without MCUXpresso SDK)

To start working on an application, create a new project. If the project already exists and is opened, skip to the next section. Follow these steps to create a new project:

1. Launch Keil µVision.
2. In the main menu, select Project > New µVision Project…, and the Create New Project dialog appears.
3. Navigate to the folder where you want to create the project, for example C:\KeilProjects\MyProject01. Type the name of the project, for example MyProject01. Click Save. See Figure 8.

![Figure 8. Create New Project dialog](image)

4. In the next dialog, select the Software Packs in the very first box.
5. Type " into the Search box, so that the device list is reduced to the devices.
6. Expand the node.
7. Click the MKV58F1M0xxx22 node, and then click OK. See Figure 9.
8. In the next dialog, expand the Device node, and tick the box next to the Startup node. See Figure 10.

9. Expand the CMSIS node, and tick the box next to the CORE node.

10. Click OK, and a new project is created. The new project is now visible in the left-hand part of Keil µVision. See Figure 11.
11. In the main menu, go to Project > Options for Target 'Target1'…, and a dialog appears.
12. Select the Target tab.
13. Select Not Used in the Floating Point Hardware option. See Figure 11.

11. In the main menu, go to Project > Options for Target 'Target1'…, and a dialog appears.
12. Select the Target tab.
13. Select Not Used in the Floating Point Hardware option. See Figure 11.

### High-speed functions execution support

Some RT (or other) platforms contain high-speed functions execution support by relocating all functions from the default Flash memory location to the RAM location for much faster code access. The feature is important especially for devices with a slow Flash interface. This section shows how to turn the RAM optimization feature support on and off.

1. In the main menu, go to Project > Options for Target 'Target1'…, and a dialog appears.
2. Select the C/C++ tab. See #unique_18.
3. In the Include Preprocessor Symbols text box, type the following:

   - **RAM_RELOCATION** — to turn the RAM optimization feature support on

   If the define is defined, all RTCEL functions are put to the RAM.
4. Click OK in the main dialog.

The RAM_RELOCATION macro places the `__attribute__((section("ram")))` attribute in front of each function declaration.

Linking the files into the project

GMCLIB requires MLIB and GFLIB to be included too. The following steps show how to include all dependent modules.

To include the library files in the project, create groups and add them.

1. Right-click the Target 1 node in the left-hand part of the Project tree, and select Add Group… from the menu. A new group with the name New Group is added.

2. Click the newly created group, and press F2 to rename it to RTCESL.

3. Right-click the RTCESL node, and select Add Existing Files to Group 'RTCESL'… from the menu.

4. Navigate into the library installation folder C:\\NXP\\RTCESL\\CM7_RTCESL_4.7_KEIL\\MLIB\\Include, and select the `mlib.h` file. If the file does not appear, set the Files of type filter to Text file. Click Add. See Figure 14.
5. Navigate to the parent folder C:\NXP\RTCESL\CM7_RTCESL_4.7_KEIL\MLIB, and select the mlib.lib file. If the file does not appear, set the Files of type filter to Library file. Click Add. See Figure 15.

6. Navigate into the library installation folder C:\NXP\RTCESL\CM7_RTCESL_4.7_KEIL\GFLIB\Include, and select the gflib.h file. If the file does not appear, set the Files of type filter to Text file. Click Add.

7. Navigate to the parent folder C:\NXP\RTCESL\CM7_RTCESL_4.7_KEIL\GFLIB, and select the gflib.lib file. If the file does not appear, set the Files of type filter to Library file. Click Add.

8. Navigate into the library installation folder C:\NXP\RTCESL\CM7_RTCESL_4.7_KEIL\GMCLIB\Include, and select the gmclib.h file. If the file does not appear, set the Files of type filter to Text file. Click Add.
9. Navigate to the parent folder C:\NXP\RTCESL\CM7_RTCESL_4.7_KEIL\GMCLIB, and select the gmclib.lib file. If the file does not appear, set the Files of type filter to Library file. Click Add.

10. Now, all necessary files are in the project tree; see Figure 16. Click Close.

![Project workspace](image)

**Figure 16. Project workspace**

**Library path setup**

The following steps show the inclusion of all dependent modules.

1. In the main menu, go to Project > Options for Target 'Target1'…, and a dialog appears.
2. Select the C/C++ tab. See Figure 17.
3. In the Include Paths text box, type the following paths (if there are more paths, they must be separated by ';') or add them by clicking the … button next to the text box:
   - "C:\NXP\RTCESL\CM7_RTCESL_4.7_KEIL\MLIB\Include"
   - "C:\NXP\RTCESL\CM7_RTCESL_4.7_KEIL\GFLIB\Include"
   - "C:\NXP\RTCESL\CM7_RTCESL_4.7_KEIL\GMCLIB\Include"
4. Click OK.
5. Click OK in the main dialog.
Type the `#include` syntax into the code. Include the library into a source file. In the new project, it is necessary to create a source file:

1. Right-click the Source Group 1 node, and Add New Item to Group 'Source Group 1'… from the menu.
2. Select the C File (.c) option, and type a name of the file into the Name box, for example 'main.c'. See Figure 18.
3. Click Add, and a new source file is created and opened up.
4. In the opened source file, include the following lines into the #include section, and create a main function:

```c
#include "mlib.h"
#include "gflib.h"
#include "gmclib.h"

int main(void)
{
    while(1);
}
```

When you click the Build (F7) icon, the project will be compiled without errors.

1.4 Library integration into project (IAR Embedded Workbench)

This section provides a step-by-step guide on how to quickly and easily include the GMCLIB into an empty project or any MCUXpresso SDK example or demo application projects using IAR Embedded Workbench. This example uses the default installation path (C:\NXP\RTCESL\CM7_RTCESL_4.7_IAR). If you have a different installation path, use that path instead. If any MCUXpresso SDK project is intended to use (for example hello_world project) go to Linking the files into the project chapter otherwise read next chapter.

New project (without MCUXpresso SDK)

This example uses the NXP MKV58F1M0xxx22 part, and the default installation path (C:\NXP\RTCESL\CM7_RTCESL_4.7_IAR) is supposed. To start working on an application, create a new project. If the project already exists and is opened, skip to the next section. Perform these steps to create a new project:

1. Launch IAR Embedded Workbench.
2. In the main menu, select Project > Create New Project… so that the "Create New Project" dialog appears. See Figure 19.

![Create New Project dialog](image)

Figure 19. Create New Project dialog

3. Expand the C node in the tree, and select the "main" node. Click OK.
4. Navigate to the folder where you want to create the project, for example, C:\IARProjects\MyProject01. Type the name of the project, for example, MyProject01. Click Save, and a new project is created. The new project is now visible in the left-hand part of IAR Embedded Workbench. See Figure 20.
5. In the main menu, go to Project > Options…, and a dialog appears.

6. In the Target tab, select the Device option, and click the button next to the dialog to select the MCU. In this example, select NXP > KV5x > NXP MKV58F1M0xxx22. Select None in the FPU option. Click OK. See Figure 21.

High-speed functions execution support

Some RT (or other) platforms contain high-speed functions execution support by relocating all functions from the default Flash memory location to the RAM location for much faster code access. The feature is important especially for devices with a slow Flash interface. This section shows how to turn the RAM optimization feature support on and off.

1. In the main menu, go to Project > Options…, and a dialog appears.
2. In the left-hand side column, select C/C++ Compiler.

3. In the right-hand side of the dialog, click the Preprocessor tab (it can be hidden on the right; use the arrow icons for navigation).

4. In the text box (in Defined symbols: (one per line)), type the following (See Figure 22):
   - **RAM_RELOCATION** — to turn the RAM optimization feature support on

   If the define is defined, all RTCEL functions are put to the RAM.

   ![Figure 22. Defined symbols](image)

   Figure 22. Defined symbols

5. Click OK in the main dialog.

   The RAM_RELOCATION macro places the `__ramfunc` attribute in front of each function declaration.

Library path variable

To make the library integration easier, create a variable that will hold the information about the library path.

1. In the main menu, go to Tools > Configure Custom Argument Variables…, and a dialog appears.

2. Click the New Group button, and another dialog appears. In this dialog, type the name of the group PATH, and click OK. See Figure 23.
3. Click on the newly created group, and click the Add Variable button. A dialog appears.

4. Type this name: RTCESL_LOC

5. To set up the value, look for the library by clicking the ‘…” button, or just type the installation path into the box: C:\NXP\RTCESL\CM7_RTCESL_4.7_IAR. Click OK.

6. In the main dialog, click OK. See Figure 24.

Linking the files into the project

GMCLIB requires MLIB and GFLIB to be included too. The following steps show the inclusion of all dependent modules.

To include the library files into the project, create groups and add them.

1. Go to the main menu Project > Add Group…

2. Type RTCESL, and click OK.

3. Click on the newly created node RTCESL, go to Project > Add Group…, and create a MLIB subgroup.

4. Click on the newly created node MLIB, and go to the main menu Project > Add Files… See Figure 26.

5. Navigate into the library installation folder C:\NXP\RTCESL\CM7_RTCESL_4.7_IAR\MLIB\Include, and select the mlib.h file. (If the file does not appear, set the file-type filter to Source Files.) Click Open. See Figure 25.
6. Navigate into the library installation folder C:\NXP\RTCESL\CM7_RTCESL_4.7_IAR\MLIB, and select the mlib.a file. If the file does not appear, set the file-type filter to Library / Object files. Click Open.

![Figure 25. Add Files dialog](image)

7. Click on the RTCESL node, go to Project > Add Group..., and create a GFLIB subgroup.

8. Click on the newly created node GFLIB, and go to the main menu Project > Add Files....

9. Navigate into the library installation folder C:\NXP\RTCESL\CM7_RTCESL_4.7_IAR\GFLIB\Include, and select the gflib.h file. (If the file does not appear, set the file-type filter to Source Files.) Click Open.

10. Navigate into the library installation folder C:\NXP\RTCESL\CM7_RTCESL_4.7_IAR\GFLIB, and select the gflib.a file. If the file does not appear, set the file-type filter to Library / Object files. Click Open.

11. Click on the RTCESL node, go to Project > Add Group..., and create a GMCLIB subgroup.

12. Click on the newly created node GMCLIB, and go to the main menu Project > Add Files....

13. Navigate into the library installation folder C:\NXP\RTCESL\CM7_RTCESL_4.7_IAR\GMCLIB\Include, and select the gmclib.h file. If the file does not appear, set the file-type filter to Source Files. Click Open.

14. Navigate into the library installation folder C:\NXP\RTCESL\CM7_RTCESL_4.7_IAR\GMCLIB, and select the gmclib.a file. If the file does not appear, set the file-type filter to Library / Object files. Click Open.

15. Now you will see the files added in the workspace. See Figure 26.

![Figure 26. Project workspace](image)

Library path setup

The following steps show the inclusion of all dependent modules:

1. In the main menu, go to Project > Options..., and a dialog appears.

2. In the left-hand column, select C/C++ Compiler.
3. In the right-hand part of the dialog, click on the Preprocessor tab (it can be hidden in the right; use the arrow icons for navigation).

4. In the text box (at the Additional include directories title), type the following folder (using the created variable):
   - $RTCESL_LOC$\MLIB\Include
   - $RTCESL_LOC$\GFLIB\Include
   - $RTCESL_LOC$\GMCLIB\Include

5. Click OK in the main dialog. See Figure 27.

![Figure 27. Library path addition](image)

Type the #include syntax into the code. Include the library included into the main.c file. In the workspace tree, double-click the main.c file. After the main.c file opens up, include the following lines into the #include section:

```c
#include "mlib.h"
#include "gflib.h"
#include "gmclib.h"
```

When you click the Make icon, the project will be compiled without errors.
Chapter 2
Algorithms in detail

2.1 GMCLIB_Clark

The GMCLIB_Clark function calculates the Clarke transformation, which is used to transform values (flux, voltage, current) from the three-phase coordinate system to the two-phase ($\alpha$-$\beta$) orthogonal coordinate system, according to the following equations:

\[
\begin{align*}
\alpha &= a \\
\beta &= \frac{1}{\sqrt{3}} b - \frac{1}{\sqrt{3}} c
\end{align*}
\]

2.1.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range $<-1 ; 1)$. The result may saturate.

The available versions of the GMCLIB_Clark function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_Clark_F16</td>
<td>GMCLIB_3COOR_T_F16 *</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td>void</td>
</tr>
</tbody>
</table>

Clarke transformation of a 16-bit fractional three-phase system input to a 16-bit fractional two-phase system. The input and output are within the fractional range $<-1 ; 1)$.

2.1.2 Declaration

The available GMCLIB_Clark functions have the following declarations:

```c
void GMCLIB_Clark_F16(const GMCLIB_3COOR_T_F16 *psIn, GMCLIB_2COOR_ALBE_T_F16 *psOut)
```

2.1.3 Function use

The use of the GMCLIB_Clark function is shown in the following examples:

```c
#include "gmclib.h"

static GMCLIB_2COOR_ALBE_T_F16 sAlphaBeta;
static GMCLIB_3COOR_T_F16 sAbc;

void Isr(void);

void main(void)
{
    /* ABC structure initialization */
    sAbc.f16A = FRAC16(0.0);
    sAbc.f16B = FRAC16(0.0);
    sAbc.f16C = FRAC16(0.0);
```
2.2 GMCLIB_ClarkInv

The GMCLIB_ClarkInv function calculates the Clarke transformation, which is used to transform values (flux, voltage, current) from the two-phase (α-β) orthogonal coordinate system to the three-phase coordinate system, according to the following equations:

\[
a = \alpha \\
b = -\frac{1}{2} \alpha + \frac{\sqrt{3}}{2} \beta \\
c = -(\alpha + b)
\]

2.2.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range \(-1 ; 1\). The result may saturate.

The available versions of the GMCLIB_ClarkInv function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_ClarkInv_F16</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td>GMCLIB_3COOR_T_F16 *</td>
<td>void</td>
</tr>
</tbody>
</table>

Inverse Clarke transformation with a 16-bit fractional two-phase system input and a 16-bit fractional three-phase output. The input and output are within the fractional range \(-1 ; 1\).

2.2.2 Declaration

The available GMCLIB_ClarkInv functions have the following declarations:

```c
void GMCLIB_ClarkInv_F16(const GMCLIB_2COOR_ALBE_T_F16 *psIn, GMCLIB_3COOR_T_F16 *psOut)
```

2.2.3 Function use

The use of the GMCLIB_ClarkInv function is shown in the following examples:

Fixed-point version:

```c
#include "gmclib.h"

static GMCLIB_2COOR_ALBE_T_F16 sAlphaBeta;
static GMCLIB_3COOR_T_F16 sAbc;
```
2.3 GMCLIB_Park

The GMCLIB_Park function calculates the Park transformation, which transforms values (flux, voltage, current) from the stationary two-phase (α-β) orthogonal coordinate system to the rotating two-phase (d-q) orthogonal coordinate system, according to the following equations:

\[
\begin{align*}
d &= \alpha \cdot \cos(\theta) + \beta \cdot \sin(\theta) \\
q &= \beta \cdot \cos(\theta) - \alpha \cdot \sin(\theta)
\end{align*}
\]

where:

- \( \theta \) is the position (angle)

### 2.3.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range \((-1 ; 1)\). The result may saturate.

The available versions of the GMCLIB_Park function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_Park_F16</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td>GMCLIB_2COOR_DQ_T_F16 *</td>
<td>void</td>
</tr>
<tr>
<td></td>
<td>GMCLIB_2COOR_SINCOS_T_F16 *</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Park transformation of a 16-bit fractional two-phase stationary system input to a 16-bit fractional two-phase rotating system, using a 16-bit fractional angle two-component (sin / cos) position information. The inputs and the output are within the fractional range \((-1 ; 1)\).

### 2.3.2 Declaration

The available GMCLIB_Park functions have the following declarations:

```c
void GMCLIB_Park_F16(const GMCLIB_2COOR_ALBE_T_F16 *psIn, const GMCLIB_2COOR_SINCOS_T_F16 *psAnglePos, GMCLIB_2COOR_DQ_T_F16 *psOut)
```
2.3.3 Function use

The use of the GMCLIB_Park function is shown in the following examples:

**Fixed-point version:**

```c
#include "gmclib.h"

static GMCLIB_2COOR_ALBE_T_F16 sAlphaBeta;
static GMCLIB_2COOR_DQ_T_F16 sDQ;
static GMCLIB_2COOR_SINCOS_T_F16 sAngle;

void Isr(void);

void main(void)
{
    /* Alpha, Beta structure initialization */
    sAlphaBeta.f16Alpha = FRAC16(0.0);
    sAlphaBeta.f16Beta = FRAC16(0.0);

    /* Angle structure initialization */
    sAngle.f16Sin = FRAC16(0.0);
    sAngle.f16Cos = FRAC16(1.0);
}

/* Periodical function or interrupt */
void Isr(void)
{
    /* Park Transformation calculation */
    GMCLIB_Park_F16(&sAlphaBeta, &sAngle, &sDQ);
}
```

2.4 GMCLIB_ParkInv

The GMCLIB_ParkInv function calculates the Park transformation, which transforms values (flux, voltage, current) from the rotating two-phase (d-q) orthogonal coordinate system to the stationary two-phase (α-β) coordinate system, according to the following equations:

\[
\begin{align*}
\alpha &= d \cdot \cos(\theta) - q \cdot \sin(\theta) \\
\beta &= d \cdot \sin(\theta) + q \cdot \cos(\theta)
\end{align*}
\]

where:

- \( \theta \) is the position (angle)

2.4.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range \(-1 \leq \cdot 1\). The result may saturate.
The available versions of the GMCLIB_ParkInv function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_ParkInv_F16</td>
<td>GMCLIB_2COOR_DQ_T_F16 *</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td>void</td>
</tr>
<tr>
<td></td>
<td>GMCLIB_2COOR_SINCOS_T_F16 *</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Inverse Park transformation of a 16-bit fractional two-phase rotating system input to a 16-bit fractional two-phase stationary system, using a 16-bit fractional angle two-component (sin / cos) position information. The inputs and the output are within the fractional range <-1 ; 1>.

### 2.4.2 Declaration

The available GMCLIB_ParkInv functions have the following declarations:

```c
void GMCLIB_ParkInv_F16(const GMCLIB_2COOR_DQ_T_F16 *psIn, const GMCLIB_2COOR_SINCOS_T_F16 *psAnglePos, GMCLIB_2COOR_ALBE_T_F16 *psOut)
```

### 2.4.3 Function use

The use of the GMCLIB_ParkInv function is shown in the following examples:

#### Fixed-point version:

```c
#include "gmclib.h"

static GMCLIB_2COOR_ALBE_T_F16 sAlphaBeta;
static GMCLIB_2COOR_DQ_T_F16 sDQ;
static GMCLIB_2COOR_SINCOS_T_F16 sAngle;

void Isr(void);

void main(void)
{
    /* D, Q structure initialization */
    sDQ.f16D = FRAC16(0.0);
    sDQ.f16Q = FRAC16(0.0);

    /* Angle structure initialization */
    sAngle.f16Sin = FRAC16(0.0);
    sAngle.f16Cos = FRAC16(1.0);
}

/* Periodical function or interrupt */
void Isr(void)
{
    /* Inverse Park Transformation calculation */
    GMCLIB_ParkInv_F16(&sDQ, &sAngle, &sAlphaBeta);
}
```
2.5 GMCLIB_DecouplingPMSM

The GMCLIB_DecouplingPMSM function calculates the cross-coupling voltages to eliminate the d-q axis coupling that causes nonlinearity of the control.

The d-q model of the motor contains cross-coupling voltage that causes nonlinearity of the control. Figure 1 represents the d-q model of the motor that can be described using the following equations, where the underlined portion is the cross-coupling voltage:

\[
\begin{align*}
    u_d &= R_s \cdot i_d + L_d \frac{di_d}{dt} + L_q \cdot \omega_{el} \cdot i_q \\
    u_q &= R_s \cdot i_q + L_d \frac{di_d}{dt} - L_q \cdot \omega_{el} \cdot i_d + \omega_{el} \cdot \psi_r
\end{align*}
\]

where:
- \(u_d, u_q\) are the d and q voltages
- \(i_d, i_q\) are the d and q currents
- \(R_s\) is the stator winding resistance
- \(L_d, L_q\) are the stator winding d and q inductances
- \(\omega_{el}\) is the electrical angular speed
- \(\psi_r\) is the rotor flux constant

To eliminate the nonlinearity, the cross-coupling voltage is calculated using the GMCLIB_DecouplingPMSM algorithm, and feedforwarded to the d and q voltages. The decoupling algorithm is calculated using the following equations:

\[
\begin{align*}
    u_{d\text{dec}} &= u_d - L_q \cdot \omega_{el} \cdot i_q \\
    u_{q\text{dec}} &= u_q + L_d \cdot \omega_{el} \cdot i_d
\end{align*}
\]

where:
- \(u_d, u_q\) are the d and q voltages; inputs to the algorithm

Figure 28. The d-q PMSM model

To eliminate the nonlinearity, the cross-coupling voltage is calculated using the GMCLIB_DecouplingPMSM algorithm, and feedforwarded to the d and q voltages. The decoupling algorithm is calculated using the following equations:
• \( u_{d_{dec}}, u_{q_{dec}} \) are the d and q decoupled voltages; outputs from the algorithm.

The fractional representation of the d-component equation is as follows:

\[
\begin{align*}
\frac{u_{d_{dec}}}{u_{max}} &= u_d - \omega_{el_{max}} \cdot i_d \left( \frac{L_q}{\omega_{el_{max}}} \cdot \frac{i_{max}}{i_{max}} \right) \\
\frac{k_d}{i_{max}} &= L_d \cdot \omega_{el_{max}} \cdot \frac{i_{max}}{i_{max}} \\
\frac{u_{d_{dec}}}{u_{max}} &= u_d - \omega_{el_{max}} \cdot i_d \cdot k_d
\end{align*}
\]

The fractional representation of the q-component equation is as follows:

\[
\begin{align*}
\frac{u_{q_{dec}}}{u_{max}} &= u_q + \omega_{el_{max}} \cdot i_q \left( \frac{L_d}{\omega_{el_{max}}} \cdot \frac{i_{max}}{i_{max}} \right) \\
\frac{k_q}{i_{max}} &= L_q \cdot \omega_{el_{max}} \cdot \frac{i_{max}}{i_{max}} \\
\frac{u_{q_{dec}}}{u_{max}} &= u_q + \omega_{el_{max}} \cdot i_q \cdot k_q
\end{align*}
\]

where:

• \( k_d, k_q \) are the scaling coefficients
• \( i_{max} \) is the maximum current
• \( u_{max} \) is the maximum voltage
• \( \omega_{el_{max}} \) is the maximum electrical speed

The \( k_d \) and \( k_q \) parameters must be set up properly.

The principle of the algorithm is depicted in Figure 2:

![Algorithm diagram](image)

**Figure 29. Algorithm diagram**

### 2.5.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range \((-1 ; 1)\). The result may saturate. The parameters use the accumulator types.

The available versions of the GMCLIB_DecouplingPMSM function are shown in the following table:
Table 6. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input/output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_DecouplingPMSM_F16</td>
<td>Input: GMCLIB_2COOR_DQ_T_F16 * GMCLIB_2COOR_DQ_T_F16 * frac16_t</td>
<td>void</td>
</tr>
<tr>
<td></td>
<td>Parameters: GMCLIB_DECOUPLINGPMSM_T_A32 *</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Output: GMCLIB_2COOR_DQ_T_F16 *</td>
<td></td>
</tr>
</tbody>
</table>

The PMSM decoupling with a 16-bit fractional d-q voltage, current inputs, and a 16-bit fractional electrical speed input. The parameters are 32-bit accumulator types. The output is a 16-bit fractional decoupled d-q voltage. The inputs and the output are within the range <-1 ; 1>.

2.5.2 GMCLIB_DECOUPLINGPMSM_T_A32 type description

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a32KdGain</td>
<td>acc32_t</td>
<td>Direct axis decoupling parameter. The parameter is within the range &lt;0 ; 65536.0)</td>
</tr>
<tr>
<td>a32KqGain</td>
<td>acc32_t</td>
<td>Quadrature axis decoupling parameter. The parameter is within the range &lt;0 ; 65536.0)</td>
</tr>
</tbody>
</table>

2.5.3 Declaration

The available GMCLIB_DecouplingPMSM functions have the following declarations:

```c
void GMCLIB_DecouplingPMSM_F16(const GMCLIB_2COOR_DQ_T_F16 *psUDQ, const GMCLIB_2COOR_DQ_T_F16 *psIDQ, frac16_t f16SpeedEl, const GMCLIB_DECOUPLINGPMSM_T_A32 *psParam, GMCLIB_2COOR_DQ_T_F16 *psUDQDec)
```

2.5.4 Function use

The use of the GMCLIB_DecouplingPMSM function is shown in the following examples:

```
Fixed-point version:

#include "gmclib.h"

static GMCLIB_2COOR_DQ_T_F16 sVoltageDQ;
static GMCLIB_2COOR_DQ_T_F16 sCurrentDQ;
static frac16_t f16AngularSpeed;
static GMCLIB_DECOUPLINGPMSM_T_A32 sDecouplingParam;
static GMCLIB_2COOR_DQ_T_F16 sVoltageDQDecoupled;

void Isr(void);

void main(void)
{
```

NXP Semiconductors

Algorithms in detail

GMCLIB User's Guide, Rev. 5, 01 November 2021
2.6 GMCLIB_DTCompLut1D

The GMCLIB_DTCompLut1D function implements dead-time-compensation algorithms that return error voltages from measured currents, knowing the inverter nonlinearity in the Look-Up Table (LUT). The aim of the GMCLIB_DTCompLut1D function is to make the inverter and the whole control loop more linear, especially around low-duty cycles, where the dead-time effect is dominant. The error voltage obtained from GMCLIB_DTCompLut1D has the most important impact in the low-motor-speed region, where the motor-supply voltage is low. The next operation is to transform the error voltages from the three-phase (a, b, c) system of coordinates to the two-phase (α, β) orthogonal system using the Clarke transformation. The multiplication by \( U_{DCBus} \) voltages is then processed and the output-compensation voltages are obtained after adding input voltages. The principle of the GMCLIB_DTCompLut1D function is shown in Figure 30.

![Figure 30. GMCLIB_DTCompLut1D function block scheme](image)

Adding the GMCLIB_DTCompLut1D function into your application has the following essentials. Each inverter introduces the total error voltage, which is caused by the dead-time and current-clamping effects and the transistor voltage drop. The actual inverter output voltage is lower than the required voltage. The total error voltage depends on the actual phase current. The example of the inverter error characteristic is shown in Figure 31.
The inverter error characteristic is assigned to the GMCLIB_DTCmpLut1D algorithm as the LUT, which simply adds the error-voltage vector to the input-voltage vector. The data for the LUT should be measured from a real inverter for the best compensation result. The target of the measurement is the voltage-error-to-phase-current dependency, as shown in Figure 32.

The LUT is defined by the table pointer and tableSize parameters. The table output is the error-voltage vector from the phase-current input vector. The GMCLIB_DTCmpLut1D algorithm processes the compensation voltage according to the following equations:

\[
\begin{align*}
    u_{A \text{error}} &= GFLIB\_Lut1D\_F16(i_{A}, \text{Table}, \text{TableSize}) \\
    u_{B \text{error}} &= GFLIB\_Lut1D\_F16(i_{B}, \text{Table}, \text{TableSize}) \\
    u_{C \text{error}} &= GFLIB\_Lut1D\_F16(i_{C}, \text{Table}, \text{TableSize})
\end{align*}
\]

Figure 33. Equations to get the error voltages components
where:

- $u_{Aerror}$, $u_{Berror}$, and $u_{Cerror}$ are the error-voltage components of the error-voltage vector.
- $i_a$, $i_b$, and $i_c$ are the current components of the measured-current vector.
- The LUT contains the inverter measured characteristic. See GMCLIB_DTCOMPLUT1D_T_F16 for details.
- The tableSize parameter is the size of the LUT parameter. See GMCLIB_DTCOMPLUT1D_T_F16 for details.
- The GFLIB_Lut1D_F16 parameter is the LUT function (GMCLIB_DTCompLut1D).

When the error voltages are calculated, the GMCLIB_DTCCompLut1D algorithm continues using the following equations:

$$
u_{\beta DTComp} = u_\alpha + (2 \times u_{AError} - u_{BError} - u_{CError}) \times \frac{u_{DCBus}}{3}$$
$$
u_{\beta DTComp} = u_\beta + (u_{BError} - u_{CError}) \times \frac{2 \times u_{DCBus}}{3}$$

Figure 34. DTCompLUT1D function equations

where:

- $u_{\alpha DTComp}$ and $u_{\beta DTComp}$ are the compensation voltage components and outputs of the GMCLIB_DTCCompLut1D function.
- $u_\alpha$ and $u_\beta$ are the voltage components of the input-voltage vector.
- $u_{Aerror}$, $u_{Berror}$, and $u_{Cerror}$ are the error-voltage components of the error-voltage vector.
- $u_{DCBus}$ is the DC-Bus voltage.

At the end of the GMCLIB_DTCCompLut1D algorithm, the error-compensation-voltage components ($\alpha$ and $\beta$) are added to the input voltage components ($\alpha$ and $\beta$). The addition with saturation is used to avoid overflow and the results of the GMCLIB_DTCCompLut1D function are the dead-time-compensated voltage components ($U_{\alpha DTComp}$ and $U_{\beta DTComp}$) as inputs for the SVMShifted function.

### 2.6.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result. The result is in the range of <-1 ; 1). The result may saturate. The parameter inlcudes the table and table size used the table types.

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input/output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_DTCCompLut1D_F16</td>
<td>Inputs: GMCLIB_3COOR_T_F16 *, GMCLIB_2COOR_ALBE_T_F16 *, frac16_t</td>
<td>void</td>
</tr>
<tr>
<td></td>
<td>Parameter: GMCLIB_DTCOMPLUT1D_T_F16 *, *</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Output: GMCLIB_2COOR_ALBE_T_F16 *</td>
<td></td>
</tr>
</tbody>
</table>

The first input argument is the structure of current components represented by the 16-bit fractional values. It contains the abscissas for which the 1-D interpolations are performed. The second input argument is the structure of voltage components represented by the two-phase ($\alpha$, $\beta$) orthogonal coordinate system. The last input argument is the measured 16-bit fractional DC-Bus voltage input.
2.6.2 GMCLIB_DTCOMPLUT1D_T_F16 type description

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pf16Table</td>
<td>frac16_t *</td>
<td>The pointer to a LUT, which contains the 16-bit fractional values of the LUT.</td>
</tr>
<tr>
<td>u16TableSize</td>
<td>uint16_t</td>
<td>The size of the LUT parameter is in the range of &lt;1 ; 15&gt;. It means that the parameter is log2 of the number of points + 1.</td>
</tr>
</tbody>
</table>

2.6.3 Declaration

The available GMCLIB_DTCompLut1D functions have the following declarations:

```c
GMCLIB_DTCompLut1D_F16(const GMCLIB_3COOR_T_F16 *psIABC, const GMCLIB_2COOR_ALBE_T_F16 *psUAlBe, frac16_t f16UDCBus, const GMCLIB_DTCOMPLUT1D_T_F16 *psParam, GMCLIB_2COOR_ALBE_T_F16 *psUAlBeDTComp)
```

2.6.4 Function use

The use of the GMCLIB_DTCompLut1D function is shown in the following example:

```c
#include "gmclib.h"

static GMCLIB_DTCOMPLUT1D_T_F16 sParam;
static GMCLIB_3COOR_T_F16 sIABC;
static GMCLIB_2COOR_ALBE_T_F16 sUAlBe, sUAlBeComp;
static frac16_t f16UDCBus;
static frac16_t f16Table[9] = {FRAC16(-0.7), FRAC16(-0.65), FRAC16(-0.55),
                              FRAC16(0.2), FRAC16(0.0),
                              FRAC16(0.2), FRAC16(-0.8), FRAC16(0.91),
                              FRAC16(0.99)};
void Isr(void);

void main(void)
{
    /* ABC currents structure initialization */
    sIABC.f16A = FRAC16(0.1);
    sIABC.f16B = FRAC16(0.3);
    sIABC.f16C = FRAC16(-0.2);
    /* Alpha Bete voltages structure initialization */
    sUAlBe.f16Alpha = FRAC16(0.25);
    sUAlBe.f16Beta = FRAC16(0.75);
    /* DC Bus voltage initialization */
    f16UDCBus = f16UDCBus;
    GMCLIB_DTCompLut1D_F16(sIABC, sUAlBe, f16UDCBus, &sParam, &sUAlBeComp);
}
```
f16UDCBus = FRAC16(0.9);
/* DC Bus voltage initialization */
sParam pf16Table = f16Table;
sParam u16TableSize = 3;
}
/* Periodical function or interrupt */
void Isr(void)
{
/* Dead-Time compensation calculation */
GMCLIB_DTCompLut1D_F16(&sIABC, &sUAlBe, f16UDCBus, &sParam, &sUAlBeComp);
}

2.7 GMCLIB_ElimDcBusRipFOC

The GMCLIB_ElimDcBusRipFOC function is used for the correct PWM duty cycle output calculation, based on the measured DC-bus voltage. The side effect is the elimination of the the DC-bus voltage ripple in the output PWM duty cycle. This function is meant to be used with a space vector modulation, whose modulation index (with respect to the DC-bus voltage) is an inverse square root of 3.

The general equation to calculate the duty cycle for the above-mentioned space vector modulation is as follows:

\[ U_{PWM} = \frac{u_{FOC}}{u_{dcbus}} \cdot \sqrt{3} \]

where:

- \( U_{PWM} \) is the duty cycle output
- \( u_{FOC} \) is the real FOC voltage
- \( u_{dcbus} \) is the real measured DC-bus voltage

Using the previous equations, the GMCLIB_ElimDcBusRipFOC function compensates an amplitude of the direct-\( \alpha \) and the quadrature-\( \beta \) component of the stator-reference voltage vector, using the formula shown in the following equations:

\[
U_{\alpha}^* = \begin{cases} 
0, & U_{\alpha} = 0 \land U_{dcbus} = 0 \\
1, & U_{\alpha} \geq 0 \land |U_{\alpha}| \geq \frac{U_{dcbus}}{\sqrt{3}} \\
-1, & U_{\alpha} < 0 \land |U_{\alpha}| \geq \frac{U_{dcbus}}{\sqrt{3}} \\
\frac{U_{\alpha}}{U_{dcbus}} \cdot \sqrt{3}, & \text{else}
\end{cases}
\]

\[
U_{\beta}^* = \begin{cases} 
0, & U_{\beta} = 0 \land U_{dcbus} = 0 \\
1, & U_{\beta} \geq 0 \land |U_{\beta}| \geq \frac{U_{dcbus}}{\sqrt{3}} \\
-1, & U_{\beta} < 0 \land |U_{\beta}| \geq \frac{U_{dcbus}}{\sqrt{3}} \\
\frac{U_{\beta}}{U_{dcbus}} \cdot \sqrt{3}, & \text{else}
\end{cases}
\]

where:

- \( U_{\alpha}^* \) is the direct-\( \alpha \) duty cycle ratio
- \( U_{\beta}^* \) is the quadrature-\( \beta \) duty cycle ratio
- \( U_{\alpha} \) is the direct-\( \alpha \) voltage
- \( U_{\beta} \) is the quadrature-\( \beta \) voltage
If the fractional arithmetic is used, the FOC and DC-bus voltages have their scales, which take place in GMCLIB_ElimDcBusRipFOC_Eq1; the equation is as follows:

\[
U_{PWM} = \frac{U_{FOC} U_{FOC\text{ max}}}{U_{dcbus} U_{dcbus\text{ max}}} \cdot \sqrt{3}
\]

where:

- \( U_{FOC} \) is the scaled FOC voltage
- \( U_{dcbus} \) is the scaled measured DC-bus voltage
- \( U_{FOC\text{ max}} \) is the FOC voltage scale
- \( U_{dcbus\text{ max}} \) is the DC-bus voltage scale

If this algorithm is used with the space vector modulation with the ratio of square root equal to 3, then the FOC voltage scale is expressed as follows:

\[
U_{FOC\text{ max}} = \frac{U_{dcbus\text{ max}}}{\sqrt{3}}
\]

The equation can be simplified as follows:

\[
U_{PWM} = \frac{U_{FOC}}{U_{dcbus}} \cdot \sqrt{3} = \frac{U_{FOC}}{U_{dcbus}}
\]

The GMCLIB_ElimDcBusRipFOC function compensates an amplitude of the direct-α and the quadrature-β component of the stator-reference voltage vector in the fractional arithmetic, using the formula shown in the following equations:

\[
U_α^* = \begin{cases} 
0, & U_α = 0 \land U_{dcbus} = 0 \\
1, & U_α > 0 \land |U_α| \geq U_{dcbus} \\
-1, & U_α < 0 \land |U_α| \geq U_{dcbus} \\
\frac{U_α}{U_{dcbus}}, & \text{else}
\end{cases}
\]

\[
U_β^* = \begin{cases} 
0, & U_β = 0 \land U_{dcbus} = 0 \\
1, & U_β > 0 \land |U_β| \geq U_{dcbus} \\
-1, & U_β < 0 \land |U_β| \geq U_{dcbus} \\
\frac{U_β}{U_{dcbus}}, & \text{else}
\end{cases}
\]

where:

- \( U_α^* \) is the direct-α duty cycle ratio
- \( U_β^* \) is the quadrature-β duty cycle ratio
- \( U_α \) is the direct-α voltage
- \( U_β \) is the quadrature-β voltage

The GMCLIB_ElimDcBusRipFOC function can be used in general motor-control applications, and it provides elimination of the voltage ripple on the DC-bus of the power stage. Figure 1 shows the results of the DC-bus ripple elimination, while compensating the ripples of the rectified voltage using a three-phase uncontrolled rectifier.
2.7.1 Available versions

This function is available in the following versions:

• Fractional output - the output is the fractional portion of the result; the result is within the range \(-1 \leq \text{result} \leq 1\). The result may saturate.

The available versions of the `GMCLIB_ElimDcBusRipFOC` function are shown in the following table:

Table 8. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_ElimDcBusRipFOC_F16</td>
<td>frac16_t</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td>void</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td></td>
</tr>
</tbody>
</table>

Compensation of a 16-bit fractional two-phase system input to a 16-bit fractional two-phase system, using a 16-bit fractional DC-bus voltage information. The DC-bus voltage input is within the fractional range \(-0 \leq \text{input} \leq 1\); the stationary (α-β) voltage input and the output are within the fractional range \(-1 \leq \text{output} \leq 1\).

2.7.2 Declaration

The available `GMCLIB_ElimDcBusRipFOC` functions have the following declarations:

```c
void GMCLIB_ElimDcBusRipFOC_F16(frac16_t f16UDCBus, const GMCLIB_2COOR_ALBE_T_F16 *psUAlBe, GMCLIB_2COOR_ALBE_T_F16 *psUAlBeComp)
```
2.7.3 Function use

The use of the `GMCLIB_ElimDcBusRipFOC` function is shown in the following example:

```c
#include "gmclib.h"

static frac16_t f16UDcBus;
static GMCLIB_2COOR_ALBE_T_F16 sUAlBe;
static GMCLIB_2COOR_ALBE_T_F16 sUAlBeComp;

void Isr(void);

void main(void)
{
    /* Voltage Alpha, Beta structure initialization */
    sUAlBe.f16Alpha = FRAC16(0.0);
    sUAlBe.f16Beta = FRAC16(0.0);

    /* DC bus voltage initialization */
    f16UDcBus = FRAC16(0.8);
}

/* Periodical function or interrupt */
void Isr(void)
{
    /* FOC Ripple elimination calculation */
    GMCLIB_ElimDcBusRipFOC_F16(f16UDcBus, &sUAlBe, &sUAlBeComp);
}
```

2.8 GMCLIB_ElimDcBusRip

The `GMCLIB_ElimDcBusRip` function is used for a correct PWM duty cycle output calculation, based on the measured DC-bus voltage. The side effect is the elimination of the the DC-bus voltage ripple in the output PWM duty cycle. This function can be used with any kind of space vector modulation; it has an additional input - the modulation index (with respect to the DC-bus voltage).

The general equation to calculate the duty cycle is as follows:

\[
U_{PWM} = \frac{u_{FOC}}{u_{dcbus}} \cdot i_{mod}
\]

where:

- \(U_{PWM}\) is the duty cycle output
- \(u_{FOC}\) is the real FOC voltage
- \(u_{dcbus}\) is the real measured DC-bus voltage
- \(i_{mod}\) is the space vector modulation index

Using the previous equations, the `GMCLIB_ElimDcBusRip` function compensates an amplitude of the direct-\(\alpha\) and the quadrature-\(\beta\) component of the stator-reference voltage vector, using the formula shown in the following equations:
where:

• $U_\alpha^*$ is the direct-\(\alpha\) duty cycle ratio
• $U_\beta^*$ is the quadrature-\(\beta\) duty cycle ratio
• $U_\alpha$ is the direct-\(\alpha\) voltage
• $U_\beta$ is the quadrature-\(\beta\) voltage

If the fractional arithmetic is used, the FOC and DC-bus voltages have their scales, which take place in GMCLIB_ElimDcBusRipFOC_Eq1; the equation is as follows:

$$U_{PWM} = \frac{U_{FOC}}{U_{dcbus}} \cdot \frac{U_{FOC_{max}}}{U_{dcbus_{max}}} \cdot i_{mod} = \frac{U_{FOC}}{U_{dcbus}} \cdot \frac{U_{FOC_{max}}}{U_{dcbus_{max}}} \cdot i_{mod}$$

where:

• $U_{FOC}$ is the scaled FOC voltage
• $U_{dcbus}$ is the scaled measured DC-bus voltage
• $U_{FOC_{max}}$ is the FOC voltage scale
• $U_{dcbus_{max}}$ is the DC-bus voltage scale

Thus, the modulation index in the fractional representation is expressed as follows:

$$i_{modfr} = \frac{U_{FOC_{max}}}{U_{dcbus_{max}}} \cdot i_{mod}$$

where:

• $i_{modfr}$ is the space vector modulation index in the fractional arithmetic

The GMCLIB_ElimDcBusRip function compensates an amplitude of the direct-\(\alpha\) and the quadrature-\(\beta\) component of the stator-reference voltage vector in the fractional arithmetic, using the formula shown in the following equations:

$$U_\alpha^* = \begin{cases} 0, & U_{\alpha} = 0 \land U_{dcbus} = 0 \lor i_{mod} = 0 \\ 1, & U_{\alpha} > 0 \land |U_{\alpha}| \geq U_{dcbus_{modfr}} \land i_{modfr} > 0 \\ -1, & U_{\alpha} < 0 \land |U_{\alpha}| \geq U_{dcbus_{modfr}} \land i_{modfr} > 0 \\ \frac{U_{\alpha}}{U_{dcbus_{modfr}}} \cdot i_{modfr}, & i_{modfr} > 0 \end{cases}$$
where:

- $U_{\alpha}^*$ is the direct-$\alpha$ duty cycle ratio
- $U_{\beta}^*$ is the quadrature-$\beta$ duty cycle ratio
- $U_{\alpha}$ is the direct-$\alpha$ voltage
- $U_{\beta}$ is the quadrature-$\beta$ voltage

The GMCLIB_ElimDcBusRip function can be used in general motor-control applications, and it provides elimination of the voltage ripple on the DC-bus of the power stage. Figure 1 shows the results of the DC-bus ripple elimination, while compensating the ripples of the rectified voltage, using a three-phase uncontrolled rectifier.

\[
U_{\beta}^* = \begin{cases} 
0, & U_{\beta} = 0 \land U_{dcbus} = 0 \land i_{modfr} = 0 \\
1, & U_{\beta} > 0 \land |U_{\beta}| \geq \frac{U_{dcbus}}{i_{modfr}} \land i_{modfr} > 0 \\
-1, & U_{\beta} < 0 \land |U_{\beta}| \geq \frac{U_{dcbus}}{i_{modfr}} \land i_{modfr} > 0 \\
\frac{U_{\beta}}{U_{dcbus}} \cdot i_{modfr}, & i_{modfr} > 0
\end{cases}
\]

The available versions of the GMCLIB_ElimDcBusRip function are shown in the following table.

2.8.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range $<-1 ; 1>$. The result may saturate. The modulation index is a non-negative accumulator type value.

The available versions of the GMCLIB_ElimDcBusRip function are shown in the following table:
Table 9. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_ElimDcBusRip_F16sas</td>
<td>frac16_t</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td>void</td>
</tr>
<tr>
<td></td>
<td>acc32_t</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td></td>
</tr>
</tbody>
</table>

Compensation of a 16-bit fractional two-phase system input to a 16-bit fractional two-phase system using a 16-bit fractional DC-bus voltage information and a 32-bit accumulator modulation index. The DC-bus voltage input is within the fractional range <0 ; 1); the modulation index is a non-negative value; the stationary (α-β) voltage input and output are within the fractional range <-1 ; 1).

2.8.2 Declaration
The available GMCLIB_ElimDcBusRip functions have the following declarations:

```c
void GMCLIB_ElimDcBusRip_F16sas(frac16_t f16UDCBus, acc32_t a32IdxMod, const GMCLIB_2COOR_ALBE_T_F16 *psUAlBeComp, GMCLIB_2COOR_ALBE_T_F16 *psUAlBe)
```

2.8.3 Function use
The use of the GMCLIB_ElimDcBusRip function is shown in the following example:

```c
#include "gmclib.h"

static frac16_t f16UDcBus;
static acc32_t a32IdxMod;
static GMCLIB_2COOR_ALBE_T_F16 sUAlBe;
static GMCLIB_2COOR_ALBE_T_F16 sUAlBeComp;

void Isr(void);

void main(void)
{
    /* Voltage Alpha, Beta structure initialization */
    sUAlBe.f16Alpha = FRAC16(0.0);
    sUAlBe.f16Beta = FRAC16(0.0);

    /* SVM modulation index */
    a32IdxMod = ACC32(1.3);

    /* DC bus voltage initialization */
    f16UDcBus = FRAC16(0.8);
}

/* Periodical function or interrupt */
void Isr(void)
{
    /* Ripple elimination calculation */
```
2.9 GMCLIB_SvmStdShifted

The GMCLIB_SvmStdShifted function is based on the GMCLIB_SvmStd function and calculates the appropriate duty-cycle ratios, which are needed to generate the given stator-reference voltage vector using a special standard space-vector modulation technique. The GMCLIB_SvmStdShifted function enables the single-shunt measurement and current reconstruction and provides the data structures to configure the ADC and PWM peripherals.

The PWM signal generation by the GMCLIB_SvmStdShifted function applies a four-voltage vector in each PWM period:

- Two of them are inactive – vectors V0 (all switch elements are OFF – 000 states) and V7 (all switch elements are ON – 111 states).
- Two of them are active vectors that generate the motor power. See the table in Figure 37.

Two phase currents are normally available as the DC-Bus current ($i_{dcb}$) during the active voltage vectors in each PWM period. It is possible to reconstruct all phase currents by measuring two different samples of $i_{dcb}$ in each PWM period. The $i_{dcb}$ current is 0 during V0 and V7. It can be used for offset measurement.
Two different phase-current samples cannot be taken when:

- **The voltage vector is crossing the SVM sector border.** Only one sample can be taken.
- **The modulation index is low.** The sampling intervals are too short and no current samples can be taken.

There are many solutions available for these problems. For this function, the shifted-PWM method was used:

- The ON/OFF times are modified (shifted), if necessary.
- The duty cycles are preserved (the applied stator voltage is the same).
1. Passing Active Vector

- Freezes the center edge.
- Moves one critical edge.
- It is used for higher modulation indexes.

2. Low modulation indexes:
- Freezes the center edge.
- Moves both side edges in opposite directions.
- It is used for low modulation indexes.

The right method is selected within the SVM algorithm and shifts are applied by the PWM driver.
2.9.1 Available versions

This function is available in the following versions:

- Fractional output - the duty-cycle outputs are the fractional portion of the result. The result is within the range of <0 ; 1). The result may saturate.

Table 10. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input/Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_SvmStdShifted_F16</td>
<td>Inputs GMCLIB_2COOR_ALBE_T_F16 *, Parameter GMCLIB_SVMSTDSHIFTED_T_F16 *, Outputs GMCLIB_ADC_CONFIG_T_F16 *, GMCLIB_PWM_CONFIG_T_F16 *</td>
<td>void</td>
</tr>
</tbody>
</table>

Standard shifted space vector modulation with a 16-bit fractional stationary (α-β) input. The parameter is pointed to by an input pointer. The outputs are pointed to by output pointers. The result type is a void type.
2.9.1.1 GMCLIB_SVMSTDSHIFTED_T_F16 type description
The input to configure the structure for the GMCLIB_SvmStdShifted function.

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16LowerLim</td>
<td>frac16_t</td>
<td>Low PWM duty-cycle limit. It influences any duty-cycle output in the sDuty structure of the PWM configuration structure. This parameter must be lower than f16UpperLim and of positive value within the range of &lt;0 ; 1) as well. It is set by the user.</td>
</tr>
<tr>
<td>f16UpperLim</td>
<td>uint16_t</td>
<td>High PWM duty-cycle limit. It influences any duty-cycle output in the sDuty structure of the PWM configuration structure. This parameter must be higher than f16LowerLim and the value must be within the range of &lt;0 ; 1) as well. It is set by the user.</td>
</tr>
<tr>
<td>f16MinT1T2</td>
<td>uint16_t</td>
<td>Minimum T1 or T2 time for a sufficient shift. It influences any shift output in the sShift structure of the PWM configuration structure. This parameter must be of a positive value and within the range of &lt;0 ; 1). It is set by the user.</td>
</tr>
</tbody>
</table>

2.9.2 GMCLIB_ADC_CONFIG_T_F16 type description
The output structure to configure the ADC peripheral.

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ui16SectorSVM</td>
<td>uint16_t</td>
<td>The output sector is an integer value within the range of &lt;1 ; 6&gt;. It is calculated by the algorithm and targeted to configure the ADC module.</td>
</tr>
<tr>
<td>f16SmplFirstEdge</td>
<td>frac16_t</td>
<td>The output delay for the first edge sample measurement. It is a 16-bit fractional value within the range of &lt;-1 ; 1). It is calculated by the algorithm and targeted to configure the ADC module.</td>
</tr>
<tr>
<td>f16SmplSecondEdge</td>
<td>frac16_t</td>
<td>The output delay for the second sample measurement. It is a 16-bit fractional value within the range of &lt;-1 ; 1). It is calculated by the algorithm and targeted to configure the ADC module.</td>
</tr>
<tr>
<td>eSmplOnePh</td>
<td>GMCLIB_PHASE_INDEX_T</td>
<td>The output value sets the first sample channel (phase) index. It is assigned from the algorithms and the enumeration value marks phase A, B, or C.</td>
</tr>
<tr>
<td>eSmplTwoPh</td>
<td>GMCLIB_PHASE_INDEX_T</td>
<td>The output value sets the second sample channel (phase) index. It is assigned from the algorithms and the enumeration value marks phase A, B, or C.</td>
</tr>
<tr>
<td>eCalcPh</td>
<td>GMCLIB_PHASE_INDEX_T</td>
<td>The output value sets the calculated sample channel (phase) index. It is assigned from the algorithms and the enumeration value marks phase A, B, or C.</td>
</tr>
</tbody>
</table>

2.9.3 GMCLIB_PWM_CONFIG_T_F16 type description
The output structure to configure the PWM peripheral.
<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sDuty</td>
<td>f16A</td>
<td>The phase-A duty cycle is a 16-bit fractional value within the range of &lt;0; 1). It is calculated by the algorithms and targeted to configure the PWM module. It may be limited by upper or lower limits.</td>
</tr>
<tr>
<td>f16B</td>
<td>frac16_t</td>
<td>The phase-B duty cycle is a 16-bit fractional value within the range of &lt;0; 1). It is calculated by the algorithms and targeted to configure the PWM module. It may be limited by upper or lower limits.</td>
</tr>
<tr>
<td>f16C</td>
<td>frac16_t</td>
<td>The phase-C duty cycle is a 16-bit fractional value within the range of &lt;0; 1). It is calculated by the algorithms and targeted to configure the PWM module. It may be limited by upper or lower limits.</td>
</tr>
<tr>
<td>sShift</td>
<td>f16A</td>
<td>The phase-A shift is a 16-bit fractional value within the range of &lt;-1; 1). It is calculated by the algorithms and targeted to configure the PWM module.</td>
</tr>
<tr>
<td>f16B</td>
<td>frac16_t</td>
<td>The phase-B shift is a 16-bit fractional value within the range of &lt;-1; 1). It is calculated by the algorithms and targeted to configure the PWM module.</td>
</tr>
<tr>
<td>f16C</td>
<td>frac16_t</td>
<td>The phase-C shift is a 16-bit fractional value within the range of &lt;-1; 1). It is calculated by the algorithms and targeted to configure the PWM module.</td>
</tr>
</tbody>
</table>

2.9.4 GMCLIB_PHASE_INDEX_T type description

The enum data type for labeling the phases in the GMCLIB_ADC_CONFIG_T_F16 structure.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>kPhaseA</td>
<td>0U</td>
<td>Phase A</td>
</tr>
<tr>
<td>kPhaseB</td>
<td>1U</td>
<td>Phase B</td>
</tr>
<tr>
<td>kPhaseC</td>
<td>2U</td>
<td>Phase C</td>
</tr>
</tbody>
</table>

2.9.5 Declaration

The available GMCLIB_SvmStdShifted function has the following declaration:

```
void GMCLIB_SvmStdShifted_F16(const GMCLIB_2COOR_ALBE_T_F16 *psIn, const GMCLIB_SVMSTDSHIFTED_T_F16 *psParam, GMCLIB_ADC_CONFIG_T_F16 *psCfgMeas, GMCLIB_PWM_CONFIG_T_F16 *psCfgPWM)
```

2.9.6 Function use

The use of the GMCLIB_SvmStdShifted function is shown in the following example:

```
Fixed-point version:

#include "gmclib.h"

static GMCLIB_2COOR_ALBE_T_F16 sAlphaBetaIn;
static GMCLIB_SVMSTDSHIFTED_T_F16 sParam;
static GMCLIB_ADC_CONFIG_T_F16 sCfgMeas;
static GMCLIB_PWM_CONFIG_T_F16 sCfgPWM;

void Isr(void);
```
void main(void)
{
    /* Alpha, Beta voltage inputs */
    sAlphaBetaIn.f16Alpha = FRAC16(0.25);
    sAlphaBetaIn.f16Beta  = FRAC16(0.1)
    /* Set SvmStdShifted parameter */
    sParam.f16LowerLim = FRAC16(0.01);
    sParam.f16UpperLim = FRAC16(0.9);
    sParam.f16MinT1T2  = FRAC16(0.1);
}
/* Periodical function or interrupt */
void Isr(void)
{
    /* SVM calculation update the output structures sCfgMeas and sCfgPWM to configure the ADC and PWM modules */
    GMCLIB_SvmStdShifted_F16(&sAlphaBetaIn, &sParam, &sCfgMeas, &sCfgPWM);
}

2.10 GMCLIB_SvmStd

The GMCLIB_SvmStd function calculates the appropriate duty-cycle ratios, which are needed for generation of the given stator-reference voltage vector, using a special standard space vector modulation technique.

The GMCLIB_SvmStd function for calculating the duty-cycle ratios is widely used in modern electric drives. This function calculates the appropriate duty-cycle ratios, which are needed for generating the given stator reference voltage vector, using a special space vector modulation technique, called standard space vector modulation.

The basic principle of the standard space vector modulation technique can be explained using the power stage diagram shown in Figure 1.

![Power stage schematic diagram](image)

Figure 40. Power stage schematic diagram
The top and bottom switches are working in a complementary mode; for example, if the top switch $S_A$ is on, then the corresponding bottom switch $S_B$ is off, and vice versa. Considering that the value 1 is assigned to the ON state of the top switch, and value 0 is assigned to the ON state of the bottom switch, the switching vector $[a, b, c]^T$ can be defined. Creating of such vector allows for numerical definition of all possible switching states. Phase-to-phase voltages can then be expressed in terms of the following states:

$$
\begin{align*}
U_{a} &= U_{DCBus} [1, -1, 0]^T \\
U_{b} &= -U_{DCBus} [0, 1, -1]^T \\
U_{c} &= U_{DCBus} [-1, 0, 1]^T
\end{align*}
$$

where $U_{DCBus}$ is the instantaneous voltage measured on the DC-bus.

Assuming that the motor is completely symmetrical, it is possible to write a matrix equation, which expresses the motor phase voltages shown in GMCLIB_SvmStd_Eq1.

$$
\begin{align*}
\begin{bmatrix} U_a \\ U_b \\ U_c \end{bmatrix} &= \frac{U_{DCBus}}{3} \begin{bmatrix} 2 & -1 & -1 \\ -1 & 2 & -1 \\ -1 & -1 & 2 \end{bmatrix} \begin{bmatrix} a \\ b \\ c \end{bmatrix}
\end{align*}
$$

In a three-phase power stage configuration (as shown in Figure 1), eight possible switching states (shown in Figure 2) are feasible. These states, together with the resulting instantaneous output line-to-line and phase voltages, are listed in Table 1.

**Table 11. Switching patterns**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>$U_a$</th>
<th>$U_b$</th>
<th>$U_c$</th>
<th>$U_{AB}$</th>
<th>$U_{BC}$</th>
<th>$U_{CA}$</th>
<th>Vector</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>O000</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>2$U_{DCBus}$/3</td>
<td>-$U_{DCBus}$/3</td>
<td>-$U_{DCBus}$/3</td>
<td>$U_{DCBus}$</td>
<td>0</td>
<td>-$U_{DCBus}$</td>
<td>$U_0$</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
<td>$U_{DCBus}$/3</td>
<td>$U_{DCBus}$/3</td>
<td>-2$U_{DCBus}$/3</td>
<td>0</td>
<td>$U_{DCBus}$</td>
<td>-$U_{DCBus}$</td>
<td>$U_{60}$</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
<td>-$U_{DCBus}$/3</td>
<td>2$U_{DCBus}$/3</td>
<td>-$U_{DCBus}$/3</td>
<td>$U_{DCBus}$</td>
<td>0</td>
<td>$U_{DCBus}$</td>
<td>$U_{120}$</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>-$2U_{DCBus}$/3</td>
<td>$U_{DCBus}$/3</td>
<td>$U_{DCBus}$/3</td>
<td>-$U_{DCBus}$</td>
<td>0</td>
<td>$U_{DCBus}$</td>
<td>$U_{240}$</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>-$U_{DCBus}$/3</td>
<td>-$U_{DCBus}$/3</td>
<td>2$U_{DCBus}$/3</td>
<td>0</td>
<td>-$U_{DCBus}$</td>
<td>$U_{DCBus}$</td>
<td>$U_{300}$</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>$U_{DCBus}$/3</td>
<td>-$2U_{DCBus}$/3</td>
<td>$U_{DCBus}$/3</td>
<td>$U_{DCBus}$</td>
<td>-$U_{DCBus}$</td>
<td>0</td>
<td>$U_{360}$</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>O111</td>
</tr>
</tbody>
</table>

The quantities of the direct-$\alpha$ and the quadrature-$\beta$ components of the two-phase orthogonal coordinate system, describing the three-phase stator voltages, are expressed using the Clark transformation, arranged in a matrix form:

$$
\begin{align*}
\begin{bmatrix} U_a \\ U_b \end{bmatrix} &= \frac{1}{2} \begin{bmatrix} 1 & -\frac{1}{2} & -\frac{1}{2} \\ \sqrt{3} & -\sqrt{3} & \sqrt{3} \end{bmatrix} \begin{bmatrix} U_a \\ U_b \end{bmatrix}
\end{align*}
$$

The three-phase stator voltages - $U_a$, $U_b$, and $U_c$ are transformed using the Clark transformation into the direct-$\alpha$ and the quadrature-$\beta$ components of the two-phase orthogonal coordinate system. The transformation results are listed in Table 2.

**Table 12. Switching patterns and space vectors**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>$U_a$</th>
<th>$U_b$</th>
<th>Vector</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>O000</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>2$U_{DCBus}$/3</td>
<td>0</td>
<td>$U_0$</td>
</tr>
</tbody>
</table>
Table 12. Switching patterns and space vectors (continued)

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>$U_a$</th>
<th>$U_b$</th>
<th>Vector</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
<td>$U_{DCBus}/3$</td>
<td>$U_{DCBus}/\sqrt{3}$</td>
<td>$U_{60}$</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
<td>$-U_{DCBus}/3$</td>
<td>$U_{DCBus}/\sqrt{3}$</td>
<td>$U_{120}$</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>$-2U_{DCBus}/3$</td>
<td>0</td>
<td>$U_{240}$</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>$-U_{DCBus}/3$</td>
<td>$-U_{DCBus}/\sqrt{3}$</td>
<td>$U_{300}$</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>$U_{DCBus}/3$</td>
<td>$-U_{DCBus}/\sqrt{3}$</td>
<td>$U_{360}$</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>$O_{111}$</td>
</tr>
</tbody>
</table>

Figure 2 depicts the basic feasible switching states (vectors). There are six nonzero vectors - $U_0, U_{60}, U_{120}, U_{180}, U_{240}$, and $U_{300}$, and two zero vectors - $O_{111}$ and $O_{000}$, usable for switching. Therefore, the principle of the standard space vector modulation lies in applying the appropriate switching states for a certain time, and thus generating a voltage vector identical to the reference one.

Figure 41. Basic space vectors

Referring to this principle, the objective of the standard space vector modulation is an approximation of the reference stator voltage vector $U_S$, with an appropriate combination of the switching patterns, composed of basic space vectors. The graphical explanation of this objective is shown in Figure 3 and Figure 4.
The stator reference voltage vector $U_S$ is phase-advanced by $30^\circ$ from the direct-$\alpha$, and thus can be generated with an appropriate combination of the adjacent basic switching states $U_0$ and $U_{60}$. These figures also indicate the resultant direct-$\alpha$ and quadrature-$\beta$ components for space vectors $U_0$ and $U_{60}$. 

Figure 42. Projection of reference voltage vector in the respective sector
In this case, the reference stator voltage vector $U_S$ is located in sector I, and can be generated using the appropriate duty-cycle ratios of the basic switching states $U_0$ and $U_{60}$. The principal equations concerning this vector location are as follows:

$$T = T_{60} + T_0 + T_{null}$$
$$U_S = \frac{T_{60}}{T} \cdot U_{60} + \frac{T_0}{T} \cdot U_0$$

where $T_{60}$ and $T_0$ are the respective duty-cycle ratios, for which the basic space vectors $T_{60}$ and $T_0$ should be applied within the time period $T$. $T_{null}$ is the time, for which the null vectors $O_{000}$ and $O_{111}$ are applied. Those duty-cycle ratios can be calculated using the following equations:

$$u_\beta = \frac{T_{60}}{T} \cdot |i_{60}| \cdot \sin 60^\circ$$
$$u_0 = \frac{T_0}{T} \cdot |i_0| + \frac{u_\beta}{\tan 60^\circ}$$

Considering that normalized magnitudes of basic space vectors are $|U_{60}| = |U_0| = 2 / \sqrt{3}$, and by the substitution of the trigonometric expressions $\sin 60^\circ$ and $\tan 60^\circ$ by their quantities $2 / \sqrt{3}$, and $\sqrt{3}$, respectively, the GMCLIB_SvmStd_Eq5 can be rearranged for the unknown duty-cycle ratios $T_{60} / T$ and $T_0 / T$ as follows:

$$\frac{T_{60}}{T} = u_\beta$$
$$U_S = \frac{T_{60}}{T} \cdot U_{120} + \frac{T_0}{T} \cdot U_{60}$$
Sector II is depicted in GMCLIB_SvmStd_Img5. In this particular case, the reference stator voltage vector $U_S$ is generated using the appropriate duty-cycle ratios of the basic switching states $T_{60}$ and $T_{120}$. The basic equations describing this sector are as follows:

$$T = T_{120} + T_{60} + T_{null}$$
$$U_S = \frac{T_{120}}{T} \cdot U_{120} + \frac{T_{60}}{T} \cdot U_{60}$$

where $T_{120}$ and $T_{60}$ are the respective duty-cycle ratios, for which the basic space vectors $U_{120}$ and $U_{60}$ should be applied within the time period $T$. $T_{null}$ is the time, for which the null vectors $O_{000}$ and $O_{111}$ are applied. These resultant duty-cycle ratios are formed from the auxiliary components, termed A and B. The graphical representation of the auxiliary components is shown in GMCLIB_SvmStd_Img6.

Figure 44. Projection of the reference voltage vector in the respective sector
The equations describing those auxiliary time-duration components are as follows:

\[
\frac{\sin 30^\circ}{\sin 120^\circ} = \frac{A}{u_\beta} \\
\frac{\sin 60^\circ}{\sin 60^\circ} = \frac{B}{u_\alpha}
\]

Equations in GMCLIB_SvmStd_Eq8 have been created using the sine rule.

The resultant duty-cycle ratios \( T_{120} / T \) and \( T_{60} / T \) are then expressed in terms of the auxiliary time-duration components, defined by GMCLIB_SvmStd_Eq9 as follows:

\[
A = \frac{1}{\sqrt{3}} \cdot u_\beta \\
B = u_\alpha
\]

Using these equations, and also considering that the normalized magnitudes of the basic space vectors are \(|U_{120}| = |U_{60}| = 2 / \sqrt{3} \), the equations expressed for the unknown duty-cycle ratios of basic space vectors \( T_{120} / T \) and \( T_{60} / T \) can be expressed as follows:

\[
\frac{T_{120}}{T} \cdot |U_{120}| = (A - B) \\
\frac{T_{60}}{T} \cdot |U_{60}| = (A + B)
\]

The duty-cycle ratios in the remaining sectors can be derived using the same approach. The resulting equations will be similar to those derived for sector I and sector II.
To depict the duty-cycle ratios of the basic space vectors for all sectors, we define:

- Three auxiliary variables:
  \[
  X = u_\beta \\
  Y = \frac{1}{2}(u_\beta + \sqrt{3} \cdot u_a) \\
  Z = \frac{1}{2}(u_\beta - \sqrt{3} \cdot u_a)
  \]

- Two expressions - \( t_1 \) and \( t_2 \), which generally represent the duty-cycle ratios of the basic space vectors in the respective sector (for example, for the first sector, \( t_1 \) and \( t_2 \) represent duty-cycle ratios of the basic space vectors \( U_{60} \) and \( U_0 \); for the second sector, \( t_1 \) and \( t_2 \) represent duty-cycle ratios of the basic space vectors \( U_{120} \) and \( U_{60} \), and so on.

The expressions \( t_1 \) and \( t_2 \), in terms of auxiliary variables \( X \), \( Y \), and \( Z \) for each sector, are listed in Table 3.

<table>
<thead>
<tr>
<th>Sectors</th>
<th>( U_0, U_{60} )</th>
<th>( U_{60}, U_{120} )</th>
<th>( U_{120}, U_{180} )</th>
<th>( U_{180}, U_{240} )</th>
<th>( U_{240}, U_{300} )</th>
<th>( U_{300}, U_0 )</th>
</tr>
</thead>
<tbody>
<tr>
<td>( t_1 )</td>
<td>( X )</td>
<td>( Y )</td>
<td>( -Y )</td>
<td>( Z )</td>
<td>( -Z )</td>
<td>( -X )</td>
</tr>
<tr>
<td>( t_2 )</td>
<td>( -Z )</td>
<td>( Z )</td>
<td>( X )</td>
<td>( -X )</td>
<td>( -Y )</td>
<td>( Y )</td>
</tr>
</tbody>
</table>

For the determination of auxiliary variables \( X \), \( Y \), and \( Z \), the sector number is required. This information can be obtained using several approaches. The approach discussed here requires the use of modified Inverse Clark transformation to transform the direct-\( \alpha \) and quadrature-\( \beta \) components into balanced three-phase quantities \( u_{ref1}, u_{ref2}, \) and \( u_{ref3} \), used for straightforward calculation of the sector number, to be shown later.

\[
\begin{align*}
  u_{ref1} &= u_\beta \\
  u_{ref2} &= -u_\beta \frac{\sqrt{3}}{2} u_a \\
  u_{ref3} &= -u_\beta \frac{-\sqrt{3}}{2} u_a
\end{align*}
\]

The modified Inverse Clark transformation projects the quadrature-\( u_\beta \) component into \( u_{ref1} \), as shown in GMCLIB_SvmStd_Iimg7 and GMCLIB_SvmStd_Iimg8, whereas voltages generated by the conventional Inverse Clark transformation project the direct-\( u_a \) component into \( u_{ref1} \).
Figure 46. Direct-$u_\alpha$ and quadrature-$u_\beta$ components of the stator reference voltage vector $U_S$, which were calculated using equations $u_\alpha = \cos \vartheta$ and $u_\beta = \sin \vartheta$, respectively.

Figure 47. Reference voltages $U_{\text{ref}1}$, $U_{\text{ref}2}$, and $U_{\text{ref}3}$

The sector identification tree shown in GMCLIB_SvmStd_Img9 can be a numerical solution of the approach shown in GMCLIB_SvmStd_Img8.
In the worst case, at least three simple comparisons are required to precisely identify the sector of the stator reference voltage vector. For example, if the stator reference voltage vector is located as shown in GMCLIB_SvmStd_Img3, the stator-reference voltage vector is phase-advanced by 30° from the direct α-axis, which results in the positive quantities of $u_{\text{ref}1}$ and $u_{\text{ref}2}$, and the negative quantity of $u_{\text{ref}3}$; see GMCLIB_SvmStd_Img8. If these quantities are used as the inputs for the sector identification tree, the product of those comparisons will be sector I. The same approach identifies sector II, if the stator-reference voltage vector is located as shown in GMCLIB_SvmStd_Img5. The variables $t_1$, $t_2$, and $t_3$, which represent the switching duty-cycle ratios of the respective three-phase system, are calculated according to the following equations:

\[
\begin{align*}
    t_1 &= \frac{T - \frac{u_{\text{ref}2}}{2}}{2} \\
    t_2 &= t_1 + t_{\text{ref}2} \\
    t_3 &= t_2 + t_{\text{ref}3}
\end{align*}
\]

where $T$ is the switching period, and $t_{\text{ref}1}$ and $t_{\text{ref}2}$ are the duty-cycle ratios of the basic space vectors given for the respective sector; Table 3, GMCLIB_SvmStd_Eq3, and GMCLIB_SvmStd_Eq15 are specific solely to the standard space vector modulation technique; other space vector modulation techniques discussed later will require deriving different equations.

The next step is to assign the correct duty-cycle ratios - $t_1$, $t_2$, and $t_3$, to the respective motor phases. This is a simple task, accomplished in a view of the position of the stator reference voltage vector; see Table 14.

### Table 14. Assignment of the duty-cycle ratios to motor phases

<table>
<thead>
<tr>
<th>Sectors</th>
<th>$U_0$, $U_60$</th>
<th>$U_{60}$, $U_{120}$</th>
<th>$U_{120}$, $U_{180}$</th>
<th>$U_{180}$, $U_{240}$</th>
<th>$U_{240}$, $U_{300}$</th>
<th>$U_{300}$, $U_{0}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>pwm_a</td>
<td>$t_3$</td>
<td>$t_2$</td>
<td>$t_1$</td>
<td>$t_1$</td>
<td>$t_2$</td>
<td>$t_3$</td>
</tr>
<tr>
<td>pwm_b</td>
<td>$t_2$</td>
<td>$t_3$</td>
<td>$t_2$</td>
<td>$t_1$</td>
<td>$t_1$</td>
<td>$t_2$</td>
</tr>
<tr>
<td>pwm_c</td>
<td>$t_1$</td>
<td>$t_1$</td>
<td>$t_2$</td>
<td>$t_3$</td>
<td>$t_3$</td>
<td>$t_2$</td>
</tr>
</tbody>
</table>

The principle of the space vector modulation technique consists of applying the basic voltage vectors $U_{\text{XXX}}$ and $O_{\text{XXX}}$ for certain time, in such a way that the main vector generated by the pulse width modulation approach for the period $T$ is equal to the original stator reference voltage vector $U_0$. This provides a great variability of arrangement of the basic vectors during the PWM period $T$. These vectors might be arranged either to lower the switching losses, or to achieve diverse results, such as center-aligned PWM, edge-aligned PWM, or a minimal number of switching states. A brief discussion of the widely used center-aligned PWM follows.

Generating the center-aligned PWM pattern is accomplished by comparing the threshold levels $pwm_a$, $pwm_b$, and $pwm_c$ with a free-running up-down counter. The timer counts to one, and then down to zero. It is supposed that when a threshold level is larger than the timer value, the respective PWM output is active. Otherwise, it is inactive; see GMCLIB_SvmStd_Img10.
GMCLIB_SvmStd_Img11 shows the waveforms of the duty-cycle ratios, calculated using standard space vector modulation.

For the accurate calculation of the duty-cycle ratios, direct-α, and quadrature-β components of the stator reference voltage vector, it must be considered that the duty cycle cannot be higher than one (100%); in other words, the assumption

$$\sqrt{a^2 + b^2} \leq 1$$

must be met.
2.10.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The result may saturate.

The available versions of the GMCLIB_SvmStd function are shown in the following table.

Table 15. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_SvmStd_F16</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td>GMCLIB_3COOR_T_F16 *</td>
<td>uint16_t</td>
</tr>
</tbody>
</table>

Standard space vector modulation with a 16-bit fractional stationary (α-β) input and a 16-bit fractional three-phase output. The result type is a 16-bit unsigned integer, which indicates the actual SVM sector. The input is within the range <-1 ; 1); the output duty cycle is within the range <0 ; 1). The output sector is an integer value within the range <1 ; 6>.

2.10.2 Declaration

The available GMCLIB_SvmStd functions have the following declarations:

```c
uint16_t GMCLIB_SvmStd_F16(const GMCLIB_2COOR_ALBE_T_F16 *psIn, GMCLIB_3COOR_T_F16 *psOut)
```
2.10.3 Function use

The use of the GMCLIB_SvmStd function is shown in the following example:

```c
#include "gmclib.h"
static uint16_t u16Sector;
static GMCLIB_2COOR_ALBE_T_F16 sAlphaBeta;
static GMCLIB_3COOR_T_F16 sAbc;

void Isr(void);
void main(void)
{
    /* Alpha, Beta structure initialization */
    sAlphaBeta.f16Alpha = FRAC16(0.0);
    sAlphaBeta.f16Beta = FRAC16(0.0);
}
/* Periodical function or interrupt */
void Isr(void)
{
    /* SVM calculation */
    u16Sector = GMCLIB_SvmStd_F16(&sAlphaBeta, &sAbc);
}
```

2.11 GMCLIB_SvmIct

The GMCLIB_SvmIct function calculates the appropriate duty-cycle ratios, which are needed for generation of the given stator-reference voltage vector using the general sinusoidal modulation technique.

The GMCLIB_SvmIct function calculates the appropriate duty-cycle ratios, needed for generation of the given stator reference voltage vector using the conventional Inverse Clark transformation. Finding the sector in which the reference stator voltage vector \( \mathbf{U}_S \) resides is similar to GMCLIB_SvmStd. This is achieved by first converting the direct-\( \alpha \) and the quadrature-\( \beta \) components of the reference stator voltage vector \( \mathbf{U}_S \) into the balanced three-phase quantities \( u_{\text{ref}1} \), \( u_{\text{ref}2} \), and \( u_{\text{ref}3} \) using the modified Inverse Clark transformation:

\[
\begin{align*}
    u_{\text{ref}1} &= u_\beta \\
    u_{\text{ref}2} &= -u_\beta \sqrt{3} u_\alpha \\
    u_{\text{ref}3} &= -u_\alpha \sqrt{3} u_\alpha
\end{align*}
\]

The calculation of the sector number is based on comparing the three-phase reference voltages \( u_{\text{ref}1} \), \( u_{\text{ref}2} \), and \( u_{\text{ref}3} \) with zero. This computation is described by the following set of rules:

\[
\begin{align*}
    a &= \begin{cases} 
        1, & u_{\text{ref}1} > 0 \\
        0, & \text{else} 
    \end{cases} \\
    b &= \begin{cases} 
        2, & u_{\text{ref}2} > 0 \\
        0, & \text{else} 
    \end{cases} \\
    c &= \begin{cases} 
        4, & u_{\text{ref}3} > 0 \\
        0, & \text{else} 
    \end{cases}
\end{align*}
\]

After passing these rules, the modified sector numbers are then derived using the following formula:
The sector numbers determined by this formula must be further transformed to correspond to those determined by the sector identification tree. The transformation which meets this requirement is shown in the following table:

Table 16. Transformation of the sectors

<table>
<thead>
<tr>
<th>Sector*</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sector</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>4</td>
<td>3</td>
<td>5</td>
</tr>
</tbody>
</table>

Use the Inverse Clark transformation for transforming values such as flux, voltage, and current from an orthogonal rotating coordination system \((u_\alpha, u_\beta)\) to a three-phase rotating coordination system \((u_a, u_b, \text{ and } u_c)\). The original equations of the Inverse Clark transformation are scaled here to provide the duty-cycle ratios in the range \(<0 ; 1)\). These scaled duty cycle ratios \(pwm_a\), \(pwm_b\), and \(pwm_c\) can be used directly by the registers of the PWM block.

\[
\begin{align*}
pwm_a &= 0.5 + \frac{u_\alpha}{2} \\
pwm_b &= 0.5 + \frac{-u_\alpha \sqrt{3} u_\beta}{4} \\
pwm_c &= 0.5 + \frac{-u_\alpha - \sqrt{3} u_\beta}{4}
\end{align*}
\]

The following figure shows the waveforms of the duty-cycle ratios calculated using the Inverse Clark transformation.
For an accurate calculation of the duty-cycle ratios and the direct-α and quadrature-β components of the stator reference voltage vector, the duty cycle cannot be higher than one (100%); in other words, the assumption \( \sqrt{\alpha^2 + \beta^2} \leq 1 \) must be met.

### 2.11.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; ℓ). The result may saturate.

The available versions of the `GMCLIB_SvmIct` function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_SvmIct_F16</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td>GMCLIB_3COOR_T_F16 *</td>
<td>uint16_t</td>
</tr>
</tbody>
</table>

General sinusoidal space vector modulation with a 16-bit fractional stationary (α-β) input and a 16-bit fractional three-phase output. The result type is a 16-bit unsigned integer, which indicates the actual SVM sector. The input is within the range <-1 ; 1); the output duty cycle is within the range <0 ; 1). The output sector is an integer value within the range <1 ; 6>.

### 2.11.2 Declaration

The available `GMCLIB_SvmIct` functions have the following declarations:

\[
\text{uint16_t GMCLIB_SvmIct_F16(const GMCLIB_2COOR_ALBE_T_F16 *psIn, GMCLIB_3COOR_T_F16 *psOut)}
\]

### 2.11.3 Function use

The use of the `GMCLIB_SvmIct` function is shown in the following example:

```c
#include "gmclib.h"

static uint16_t u16Sector;
static GMCLIB_2COOR_ALBE_T_F16 sAlphaBeta;
static GMCLIB_3COOR_T_F16 sAbc;

void Isr(void);

void main(void)
{
    /* Alpha, Beta structure initialization */
    sAlphaBeta.f16Alpha = FRAC16(0.0);
    sAlphaBeta.f16Beta = FRAC16(0.0);
}

/* Periodical function or interrupt */
void Isr(void)
{
    /* SVM calculation */
    u16Sector = GMCLIB_SvmIct_F16(&sAlphaBeta, &sAbc);
}
```
2.12 GMCLIB_SvmU0n

The GMCLIB_SvmU0n function calculates the appropriate duty-cycle ratios, which are needed for generation of the given stator-reference voltage vector using the general sinusoidal modulation technique.

The GMCLIB_SvmU0n function for calculating of duty-cycle ratios is widely used in modern electric drives. This function calculates the appropriate duty-cycle ratios, which are needed for generating the given stator reference voltage vector using a special space vector modulation technique called space vector modulation with $O_{000}$ nulls, where only one type of null vector $O_{000}$ is used (all bottom switches are turned on in the inverter).

The derivation approach of the space vector modulation technique with $O_{000}$ nulls is in many aspects identical to the approach presented in GMCLIB_SvmStd. However, a distinct difference lies in the definition of the variables $t_1$, $t_2$, and $t_3$ that represent switching duty-cycle ratios of the respective phases:

\[
\begin{align*}
    t_1 &= 0 \\
    t_2 &= t_1 + t_{-1} \\
    t_3 &= t_2 + t_{-2}
\end{align*}
\]

where $T$ is the switching period, and $t_{-1}$ and $t_{-2}$ are the duty-cycle ratios of the basic space vectors that are defined for the respective sector in Table 2-7.

The generally used center-aligned PWM is discussed briefly in the following sections. Generating the center-aligned PWM pattern is accomplished practically by comparing the threshold levels $pwm_a$, $pwm_b$, and $pwm_c$ with the free-running up/down counter. The timer counts up to 1 (0x7FFF) and then down to 0 (0x0000). It is supposed that when a threshold level is larger than the timer value, the respective PWM output is active. Otherwise it is inactive (see GMCLIB_SvmU0n_Img1).

![Centre-Aligned PWM](GMCLIB_SvmU0n_Img1)

Figure 52. Space vector modulation technique with $O_{000}$ nulls — center-aligned PWM
Figure GMCLIB_SvmU0n_Img1 shows calculated waveforms of the duty cycle ratios using space vector modulation with $O_{000}$ nulls.

For an accurate calculation of the duty-cycle ratios, direct-$\alpha$, and quadrature-$\beta$ components of the stator reference voltage vector, consider that the duty cycle cannot be higher than one (100 %); in other words, the assumption $\sqrt{\alpha^2 + \beta^2} \leq 1$

must be met.

![Components of the Stator Reference Voltage Vector](image)

![Space Vector Modulation Technique with $O_{000}$ Nulls](image)

Figure 53. Space vector modulation technique with $O_{000}$ nulls

### 2.12.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range $<0 ; 1)$. The result may saturate.

The available versions of the GMCLIB_SvmU0n function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_SvmU0n_F16</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td>GMCLIB_3COOR_T_F16 *</td>
<td>uint16_t</td>
</tr>
</tbody>
</table>

General sinusoidal space vector modulation with a 16-bit fractional stationary ($\alpha$-$\beta$) input, and a 16-bit fractional three-phase output. The result type is a 16-bit unsigned integer, which indicates the actual
Table 18. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVM sector. The input is within the range &lt;-1 ; 1); the output duty cycle is within the range &lt;0 ; 1). The output sector is an integer value within the range &lt;1 ; 6&gt;.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2.12.2 Declaration

The available GMCLIB_SvmU0n functions have the following declarations:

```c
uint16_t GMCLIB_SvmU0n_F16(const GMCLIB_2COOR_ALBE_T_F16 *psIn, GMCLIB_3COOR_T_F16 *psOut)
```

2.12.3 Function use

The use of the GMCLIB_SvmU0n function is shown in the following example:

```c
#include "gmclib.h"

static uint16_t u16Sector;
static GMCLIB_2COOR_ALBE_T_F16 sAlphaBeta;
static GMCLIB_3COOR_T_F16 sAbc;

void Isr(void);

void main(void)
{
    /* Alpha, Beta structure initialization */
    sAlphaBeta.f16Alpha = FRAC16(0.0);
    sAlphaBeta.f16Beta = FRAC16(0.0);
}

/* Periodical function or interrupt */
void Isr(void)
{
    /* SVM calculation */
    u16Sector = GMCLIB_SvmU0n_F16(&sAlphaBeta, &sAbc);
}
```

2.13 GMCLIB_SvmU7n

The GMCLIB_SvmU7n function calculates the appropriate duty-cycle ratios, which are needed for generation of the given stator-reference voltage vector, using the general sinusoidal modulation technique.

The GMCLIB_SvmU7n function for calculating the duty-cycle ratios is widely used in modern electric drives. This function calculates the appropriate duty-cycle ratios, which are needed for generating the given stator reference voltage vector using a special space vector modulation technique called space vector modulation with \(O_{111}\) nulls, where only one type of null vector \(O_{111}\) is used (all top switches are turned on in the inverter).

The derivation approach of the space vector modulation technique with \(O_{111}\) nulls is identical (in many aspects) to the approach presented in GMCLIB_SvmStd. However, a distinct difference lies in the definition of variables \(t_1\), \(t_2\), and \(t_3\) that represent switching duty-cycle ratios of the respective phases:
where $T$ is the switching period, and $t_1$ and $t_2$ are the duty-cycle ratios of the basic space vectors defined for the respective sector in Table 2-7.

The generally-used center-aligned PWM is discussed briefly in the following sections. Generating the center-aligned PWM pattern is accomplished by comparing threshold levels pwm_a, pwm_b, and pwm_c with the free-running up/down counter. The timer counts up to 1 ($0x7FFF$) and then down to 0 ($0x0000$). It is supposed that when a threshold level is larger than the timer value, the respective PWM output is active. Otherwise, it is inactive (see GMCLIB_SvmU7n_Img1).

Figure 54. Space vector modulation technique with $O_{111}$ nulls — center-aligned PWM

Figure GMCLIB_SvmU7n_Img1 shows calculated waveforms of the duty-cycle ratios using Space Vector Modulation with $O_{111}$ nulls.

For an accurate calculation of the duty-cycle ratios, direct-$\alpha$, and quadrature-$\beta$ components of the stator reference voltage vector, it must be considered that the duty cycle cannot be higher than one (100 %); in other words, the assumption

$$\sqrt{\alpha^2 + \beta^2} \leq 1$$

must be met.
2.13.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The result may saturate.

The available versions of the GMCLIB_SvmU7n function are shown in the following table:

Table 19. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_SvmU7n_F16</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td>GMCLIB_3COOR_T_F16 *</td>
<td>uint16_t</td>
</tr>
</tbody>
</table>

General sinusoidal space vector modulation with a 16-bit fractional stationary (α-β) input and a 16-bit fractional three-phase output. The result type is a 16-bit unsigned integer, which indicates the actual SVM sector. The input is within the range <-1 ; 1); the output duty cycle is within the range <0 ; 1). The output sector is an integer value within the range <1 ; 6>.

2.13.2 Declaration

The available GMCLIB_SvmU7n functions have the following declarations:

```c
uint16_t GMCLIB_SvmU7n_F16(const GMCLIB_2COOR_ALBE_T_F16 *psIn, GMCLIB_3COOR_T_F16 *psOut)
```
2.13.3 Function use

The use of the GMCLIB_SvmU7n function is shown in the following example:

```c
#include "gmclib.h"

static uint16_t u16Sector;
static GMCLIB_2COOR_ALBE_T_F16 sAlphaBeta;
static GMCLIB_3COOR_T_F16 sAbc;

void Isr(void);

void main(void)
{
    /* Alpha, Beta structure initialization */
    sAlphaBeta.f16Alpha = FRAC16(0.0);
    sAlphaBeta.f16Beta = FRAC16(0.0);
}

/* Periodical function or interrupt */
void Isr(void)
{
    /* SVM calculation */
    u16Sector = GMCLIB_SvmU7n_F16(&sAlphaBeta, &sAbc);
}
```

2.14 GMCLIB_SvmDpwm

The GMCLIB_SvmDpwm function calculates the appropriate duty-cycle ratios needed for the generation of the given stator-reference voltage vector using the general non-sinusoidal modulation technique. The GMCLIB_SvmDpwm function is a subset of the GMCLIB_SvmExDpwm function and includes a power factor angle input. Both functions are identical if \( \varphi = 0 \).

The GMCLIB_SvmDpwm function belongs to the discontinuous PWM modulation techniques for 3-phase voltage inverters. The advantages of the discontinuous PWM technique are lower switching losses, but, on the other hand, it can cause higher harmonic distortion at low modulation indexes. The current sensing at low modulation indexes is more complicated and less precise when compared with the symmetrical modulation techniques like GMCLIB_SvmStd. Therefore, the discontinuous and continous SVM are usually combined together.

Finding the sector in which the reference stator voltage vector \( U_S \) resides is similar to GMCLIB_SvmStd. This is achieved by converting the direct-\( \alpha \) and quadrature-\( \beta \) components of the reference stator voltage vector \( U_S \) into the balanced 3-phase quantities \( u_{ref1}, u_{ref2}, \) and \( u_{ref3} \) using the modified Inverse Clarke transformation:

\[
\begin{align*}
    u_{ref1} &= u_\beta \\
    u_{ref2} &= \frac{\sqrt{3}}{2}u_a - \frac{\sqrt{3}}{2}u_b \\
    u_{ref3} &= -\frac{\sqrt{3}}{2}u_a - \frac{\sqrt{3}}{2}u_b
\end{align*}
\]

The sector calculation is based on comparing the 3-phase reference voltages \( u_{ref1}, u_{ref2}, \) and \( u_{ref3} \) with zero. This computation is described by the following figure:
The knowledge of the sector is necessary for the current sensing especially when shunt resistors are used. The `GMCLIB_SvmDpwm` function does not require the sector directly, but it requires the portion identification explained in the following. The Inverse Clarke transformation converts the \( u_\alpha \), \( u_\beta \) voltage components of the reference stator voltage vector \( U_3 \) to 3-phase voltage components \( u_a \), \( u_b \), and \( u_c \). The portion identification selects the portion from the \( u_a \), \( u_b \), and \( u_c \) voltages, based on the following conditions.

Finally, the corresponding duty cycle is selected according to the portion from the column of the following table.

### Table 20. Duty cycle calculation from portions

<table>
<thead>
<tr>
<th>Portions</th>
<th>I</th>
<th>II</th>
<th>III</th>
<th>IV</th>
<th>V</th>
<th>VI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage boundaries</td>
<td>( U_{330}, U_{30} )</td>
<td>( U_{30}, U_{90} )</td>
<td>( U_{90}, U_{150} )</td>
<td>( U_{150}, U_{210} )</td>
<td>( U_{210}, U_{270} )</td>
<td>( U_{270}, U_{330} )</td>
</tr>
<tr>
<td><code>pwm_a</code></td>
<td>1</td>
<td>0 - ( u_{ref3} )</td>
<td>1 + ( u_{ref2} )</td>
<td>0</td>
<td>1 - ( u_{ref3} )</td>
<td>0 + ( u_{ref2} )</td>
</tr>
<tr>
<td><code>pwm_b</code></td>
<td>1 - ( u_{ref2} )</td>
<td>0 + ( u_{ref1} = u_\beta )</td>
<td>1</td>
<td>0 - ( u_{ref2} )</td>
<td>1 + ( u_{ref1} = 1 + u_\beta )</td>
<td>0</td>
</tr>
<tr>
<td><code>pwm_c</code></td>
<td>1 + ( u_{ref3} )</td>
<td>0</td>
<td>1 - ( u_{ref1} = 1 - u_\beta )</td>
<td>0 + ( u_{ref3} )</td>
<td>1</td>
<td>0 - ( u_{ref1} = 0 - u_\beta )</td>
</tr>
</tbody>
</table>

#### 2.14.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range \( <0; 1) \). The result may saturate.

The available versions of the `GMCLIB_SvmDpwm` function are shown in the following table:
Table 21. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCLIB_SvmDpwm_F16</td>
<td>GMCLIB_2COOR_ALBE_T_F16 *</td>
<td>GMCLIB_3COOR_T_F16 *</td>
<td>uint16_t</td>
</tr>
</tbody>
</table>

Standard discontinuous PWM with a 16-bit fractional stationary (α-β) input, and a 16-bit fractional 3-phase output. The result type is a 16-bit unsigned integer, which indicates the actual SVM sector. The input is within the range <-1 ; 1); the output duty cycle is within the range <0 ; 1). The output sector is an integer value within the range <1 ; 6>.

2.14.2 Declaration

The available GMCLIB_SvmDpwm functions have the following declarations:

```c
uint16_t GMCLIB_SvmDpwm_F16(const GMCLIB_2COOR_ALBE_T_F16 *psIn, GMCLIB_3COOR_T_F16 *psOut)
```

2.14.3 Function use

The use of the GMCLIB_SvmDpwm function is shown in the following example:

```c
#include "gmclib.h"
static uint16_t u16Sector;
static GMCLIB_2COOR_ALBE_T_F16 sAlphaBeta;
static GMCLIB_3COOR_T_F16 sAbc;

void Isr(void);

void main(void)
{
    /* Alpha, Beta structure initialization */
    sAlphaBeta.f16Alpha = FRAC16(0.0);
    sAlphaBeta.f16Beta = FRAC16(0.0);
    /* Periodical function or interrupt */
}

void Isr(void)
{
    /* Standard Discountinues PWM SVM calculation */
    u16Sector = GMCLIB_SvmGenDpwm_F16(&sAlphaBeta, &sAbc);
}
```

2.15 GMCLIB_SvmExDpwm

The GMCLIB_SvmExDpwm function calculates the appropriate duty-cycle ratios needed for the generation of the given stator-reference voltage vector using the general non-sinusoidal modulation technique. The GMCLIB_SvmExDpwm function is a superset of the GMCLIB_SvmDpwm function without the power factor angle input.

The GMCLIB_SvmExDpwm function belongs to the discontinuous PWM modulation techniques for a 3-phase voltage inverter. The advantages of the discontinuous PWM technique are lower switching losses, but, on the other hand, it can cause higher harmonic distortion at low modulation indexes. The current sensing at low modulation indexes is more complicated and less precise when compared to the symmetrical modulation techniques like GMCLIB_SvmStd. Therefore, the discontinuous and continuous SVM are usually combined together.
Finding the sector in which the reference stator voltage vector $U_S$ resides is similar to GMCLIB_SvmStd. This is achieved by converting the direct-$\alpha$ and quadrature-$\beta$ components of the reference stator voltage vector $U_S$ into the balanced 3-phase quantities $u_{ref1}$, $u_{ref2}$, and $u_{ref3}$ using the modified Inverse Clarke transformation:

$$
\begin{align*}
    u_{ref1} &= u_\beta \\
    u_{ref2} &= \frac{\sqrt{3}}{2} (u_\alpha - u_\beta) \\
    u_{ref3} &= -\frac{\sqrt{3}}{2} (u_\alpha + u_\beta)
\end{align*}
$$

The sector calculation is based on comparing the 3-phase reference voltages $u_{ref1}$, $u_{ref2}$, and $u_{ref3}$ with zero. This computation is described by the following figure:

![Figure 58. Identification of the sector number](image)

The knowledge of the sector is necessary for the current sensing especially when shunt resistors are used. The GMCLIB_SvmExDpwm function does not require the sector directly, but it requires the portion identification explained in following text. The Park transformation uses the phase shift of the generated phase voltages and currents - $\phi$ angle to rotate the reference stator voltage vector $U_S$ to $U_S^*$ with the $u_a^*$, $u_b^*$ components. The inverse Clarke transformation converts the $u_a^*$, $u_b^*$ voltage components to 3-phase voltage components $u_a^*$, $u_b^*$, and $u_c^*$. The portion identification selects the portion from the $u_a^*$, $u_b^*$, and $u_c^*$ voltages based on the following conditions.

![Figure 59. Identification of the portion number](image)

Finally, the corresponding duty cycle is selected according to the portion from the column of the following table.

<table>
<thead>
<tr>
<th>Portions</th>
<th>I</th>
<th>II</th>
<th>III</th>
<th>IV</th>
<th>V</th>
<th>VI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage boundaries</td>
<td>$U_{330}, U_{30}$</td>
<td>$U_{30}, U_{90}$</td>
<td>$U_{90}, U_{150}$</td>
<td>$U_{150}, U_{210}$</td>
<td>$U_{210}, U_{270}$</td>
<td>$U_{270}, U_{330}$</td>
</tr>
<tr>
<td>$pwm_a$</td>
<td>1</td>
<td>0 - $u_{ref3}$</td>
<td>1 + $u_{ref2}$</td>
<td>0</td>
<td>1 - $u_{ref3}$</td>
<td>0 + $u_{ref2}$</td>
</tr>
</tbody>
</table>

*Table continues on the next page...*
Table 22. Duty cycle calculation from portions (continued)

<table>
<thead>
<tr>
<th></th>
<th>$1 - u_{\text{ref}2}$</th>
<th>$0 + u_{\text{ref}1} = u_\beta$</th>
<th>$1$</th>
<th>$0 - u_{\text{ref}2}$</th>
<th>$1 + u_{\text{ref}1} = 1 + u_\beta$</th>
<th>$0$</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>pwm_b</code></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>pwm_c</code></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2.15.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range $<0 ; 1)$. The result may saturate.

The available versions of the `GMCLIB_SvmExDpwm` function are shown in the following table:

Table 23. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>GMCLIB_SvmExDpwm_F16</code></td>
<td><code>GMCLIB_2COOR_ALBE_T_F16 *</code> <code>GMCLIB_2COOR_SINCOS_T_F16 *</code></td>
<td><code>GMCLIB_3COOR_T_F16 *</code></td>
<td><code>uint16_t</code></td>
</tr>
</tbody>
</table>

Extended discontinuous PWM with a 16-bit fractional stationary ($\alpha$-$\beta$) input, the second input using a 16-bit fractional ($\sin(\varphi) / \cos(\varphi)$) structure of $\varphi$ angle (-1/6 ; 1/6) in fraction corresponding (-π/6 ; π/6) in radians - angle of the power factor; it is a phase shift of the generated phase voltages and currents and a 16-bit fractional 3-phase output. The result type is a 16-bit unsigned integer which indicates the actual SVM sector. The input is within the range <-1 ; 1); the output duty cycle is within the range <0 ; 1). The output sector is an integer value within the range <1 ; 6>.

2.15.2 Declaration

The available `GMCLIB_SvmExDpwm` functions have the following declarations:

```c
uint16_t GMCLIB_SvmExDpwm_F16(const GMCLIB_2COOR_ALBE_T_F16 *psIn,const GMCLIB_2COOR_SINCOS_T_F16 *psAngle, GMCLIB_3COOR_T_F16 *psOut)
```

2.15.3 Function use

The use of the `GMCLIB_SvmExDpwm` function is shown in the following example:

```c
#include "gmclib.h"

static uint16_t u16Sector;
static GMCLIB_2COOR_ALBE_T_F16 sAlphaBeta;
static GMCLIB_2COOR_SINCOS_T_F16 sAlphaBeta;
static GMCLIB_3COOR_T_F16 sAbc;

void Isr(void);

void main(void)
{
    /* Alpha, Beta structure initialization */
    sAlphaBeta.f16Alpha = FRAC16(0.0);
    sAlphaBeta.f16Beta = FRAC16(0.0);

    /* Power factor angle structure initialization */
    sAngle.f16Cos = FRAC16(1.0);
    sAngle.f16Sin = FRAC16(0.0);
}
```
/ * Periodical function or interrupt *
 void Isr(void)
 {
  /* Extended Discontinues PWM calculation */
  ul6Sector = GMCLIB_SvmExDpwm_F16(&sAlphaBeta, &sAngle, &sAbc);
 }
Appendix A
Library types

A.1 bool_t

The bool_t type is a logical 16-bit type. It is able to store the boolean variables with two states: TRUE (1) or FALSE (0). Its definition is as follows:

\[
\text{typedef unsigned short bool_t;}\]

The following figure shows the way in which the data is stored by this type:

Table 24. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Unused</th>
<th>Logical</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1</td>
<td>1</td>
</tr>
<tr>
<td>FALSE</td>
<td>0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
</tbody>
</table>

To store a logical value as bool_t, use the FALSE or TRUE macros.

A.2 uint8_t

The uint8_t type is an unsigned 8-bit integer type. It is able to store the variables within the range <0 ; 255>. Its definition is as follows:

\[
\text{typedef unsigned char uint8_t;}\]

The following figure shows the way in which the data is stored by this type:

Table 25. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>255</td>
<td>1 1 1 1 1 1 1 1</td>
</tr>
</tbody>
</table>

To store a logical value as uint8_t, use the FALSE or TRUE macros.
A.3 uint16_t

The uint16_t type is an unsigned 16-bit integer type. It is able to store the variables within the range \(0 \leq 65535\). Its definition is as follows:

```c
typedef unsigned short uint16_t;
```

The following figure shows the way in which the data is stored by this type:

<table>
<thead>
<tr>
<th>Value</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>65535</td>
<td>1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1</td>
</tr>
<tr>
<td>5</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 1</td>
</tr>
<tr>
<td>15518</td>
<td>0 0 1 1 1 1 0 0 1 0 0 1 1 1 1 0</td>
</tr>
<tr>
<td>40768</td>
<td>1 0 0 1 1 1 1 1 0 1 0 0 0 0 0 0</td>
</tr>
</tbody>
</table>
A.4  uint32_t

The uint32_t type is an unsigned 32-bit integer type. It is able to store the variables within the range <0 ; 4294967295>. Its definition is as follows:

typedef unsigned long uint32_t;

The following figure shows the way in which the data is stored by this type:

Table 27. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>4294967295</td>
<td>F F F F</td>
</tr>
<tr>
<td>2147483648</td>
<td>8 0 0 0</td>
</tr>
<tr>
<td>55977296</td>
<td>0 3 5 6</td>
</tr>
<tr>
<td>3451051828</td>
<td>C D B 2</td>
</tr>
</tbody>
</table>

A.5  int8_t

The int8_t type is a signed 8-bit integer type. It is able to store the variables within the range <-128 ; 127>. Its definition is as follows:

typedef char int8_t;

The following figure shows the way in which the data is stored by this type:

Table 28. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>127</td>
<td>0 1 1 1 1 1 1 1</td>
<td>1 1 1 1</td>
</tr>
<tr>
<td>-128</td>
<td>1 0 0 0 0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>60</td>
<td>0 0 1 1 1 1 1 0</td>
<td>0 0 0 0</td>
</tr>
</tbody>
</table>

Table continues on the next page...
Table 28. Data storage (continued)

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>-97</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>F</td>
</tr>
</tbody>
</table>

A.6 int16_t

The int16_t type is a signed 16-bit integer type. It is able to store the variables within the range <-32768 ; 32767>. Its definition is as follows:

typedef short int16_t;

The following figure shows the way in which the data is stored by this type:

Table 29. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>32767</td>
<td>0</td>
<td>1111111111111111</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>F</td>
</tr>
<tr>
<td></td>
<td>-32768</td>
<td>0000000000000000</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>0</td>
</tr>
<tr>
<td>15518</td>
<td>0</td>
<td>1100110110011110</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>C</td>
</tr>
<tr>
<td></td>
<td>-24768</td>
<td>0111110100000000</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>F</td>
</tr>
</tbody>
</table>

A.7 int32_t

The int32_t type is a signed 32-bit integer type. It is able to store the variables within the range <-2147483648 ; 2147483647>. Its definition is as follows:

typedef long int32_t;

The following figure shows the way in which the data is stored by this type:

Table 30. Data storage

Table continues on the next page...
A.8 frac8_t

The frac8_t type is a signed 8-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is as follows:

```c
typedef char frac8_t;
```

The following figure shows the way in which the data is stored by this type:

### Table 31. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Fractional</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.99219</td>
<td>0</td>
<td>1 1 1 1 1 1 1 1</td>
</tr>
<tr>
<td>-1.0</td>
<td>1</td>
<td>0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>0.46875</td>
<td>0</td>
<td>0 1 1 1 1 1 0 0</td>
</tr>
<tr>
<td>-0.75781</td>
<td>1</td>
<td>0 0 1 1 1 1 1 1</td>
</tr>
</tbody>
</table>

To store a real number as frac8_t, use the FRAC8 macro.
A.9 frac16_t

The frac16_t type is a signed 16-bit fractional type. It is able to store the variables within the range \(<-1 ; 1\). Its definition is as follows:

```c
typedef short frac16_t;
```

The following figure shows the way in which the data is stored by this type:

Table 32. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Fractional</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.99997</td>
<td>0</td>
<td>1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1</td>
</tr>
<tr>
<td>-1.0</td>
<td>1</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>0.47357</td>
<td>0</td>
<td>0 1 1 1 1 1 0 0 1 0 0 1 1 1 1 0</td>
</tr>
<tr>
<td>-0.75586</td>
<td>1</td>
<td>0 0 1 1 1 1 1 0 1 0 0 0 0 0 0 0</td>
</tr>
</tbody>
</table>

To store a real number as frac16_t, use the FRAC16 macro.

A.10 frac32_t

The frac32_t type is a signed 32-bit fractional type. It is able to store the variables within the range \(<-1 ; 1\). Its definition is as follows:

```c
typedef long frac32_t;
```

The following figure shows the way in which the data is stored by this type:

Table 33. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Fractional</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9999999995</td>
<td>0</td>
<td>1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1</td>
</tr>
</tbody>
</table>

Table continues on the next page...
Table 33. Data storage (continued)

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Integer</th>
<th>Fractional</th>
</tr>
</thead>
<tbody>
<tr>
<td>255.9921875</td>
<td>0</td>
<td>11111111</td>
<td>11111111</td>
</tr>
<tr>
<td>-256.0</td>
<td>1</td>
<td>00000000</td>
<td>00000000</td>
</tr>
<tr>
<td>1.0</td>
<td>0</td>
<td>00000001</td>
<td>00000000</td>
</tr>
<tr>
<td>-1.0</td>
<td>1</td>
<td>11111111</td>
<td>11111111</td>
</tr>
<tr>
<td>13.7890625</td>
<td>0</td>
<td>01110111</td>
<td>11100010</td>
</tr>
<tr>
<td>-89.71875</td>
<td>1</td>
<td>10011101</td>
<td>01100100</td>
</tr>
</tbody>
</table>

To store a real number as `frac32_t`, use the `FRAC32` macro.

A.11 acc16_t

The `acc16_t` type is a signed 16-bit fractional type. It is able to store the variables within the range <-256 ; 256). Its definition is as follows:

```c
typedef short acc16_t;
```

The following figure shows the way in which the data is stored by this type:

Table 34. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Integer</th>
<th>Fractional</th>
</tr>
</thead>
<tbody>
<tr>
<td>255.9921875</td>
<td>0</td>
<td>11111111</td>
<td>11111111</td>
</tr>
<tr>
<td>-256.0</td>
<td>1</td>
<td>00000000</td>
<td>00000000</td>
</tr>
<tr>
<td>1.0</td>
<td>0</td>
<td>00000001</td>
<td>00000000</td>
</tr>
<tr>
<td>-1.0</td>
<td>1</td>
<td>11111111</td>
<td>11111111</td>
</tr>
<tr>
<td>13.7890625</td>
<td>0</td>
<td>01110111</td>
<td>11100010</td>
</tr>
<tr>
<td>-89.71875</td>
<td>1</td>
<td>10011101</td>
<td>01100100</td>
</tr>
</tbody>
</table>

GMCLIB User's Guide, Rev. 5, 01 November 2021
To store a real number as acc16_t, use the ACC16 macro.

A.12 acc32_t

The acc32_t type is a signed 32-bit accumulator type. It is able to store the variables within the range <-65536 ; 65536). Its definition is as follows:

```c
typedef long acc32_t;
```

The following figure shows the way in which the data is stored by this type:

Table 35. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>S</th>
<th>Integer</th>
<th>Fractional</th>
</tr>
</thead>
<tbody>
<tr>
<td>65535.999969</td>
<td>7</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>-65536.0</td>
<td>8</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1.0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-1.0</td>
<td>F</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>23.789734</td>
<td>0</td>
<td>0</td>
<td>B</td>
</tr>
<tr>
<td>-1171.306793</td>
<td>F</td>
<td>D</td>
<td>B</td>
</tr>
</tbody>
</table>

To store a real number as acc32_t, use the ACC32 macro.

A.13 float_t

The float_t type is a signed 32-bit single precision floating-point type, defined by IEEE 754. It is able to store the full precision (normalized) finite variables within the range <-3.40282 · 10^{38} ; 3.40282 · 10^{38}) with the minimum resolution of 2^{-23}. The smallest normalized number is ±1.17549 · 10^{-38}. Nevertheless, the denormalized numbers (with reduced precision) reach yet lower values, from ±1.40130 · 10^{-45} to ±1.17549 · 10^{-38}. The standard also defines the additional values:

- Negative zero
- Infinity
- Negative infinity
- Not a number

The 32-bit type is composed of:

- Sign (bit 31)
- Exponent (bits 23 to 30)
- Mantissa (bits 0 to 22)

The conversion of the number is straightforward. The sign of the number is stored in bit 31. The binary exponent is decoded as an integer from bits 23 to 30 by subtracting 127. The mantissa (fraction) is stored in bits 0 to 22. An invisible leading bit (it is not
actually stored) with value 1.0 is placed in front; therefore, bit 23 has a value of 0.5, bit 22 has a value 0.25, and so on. As a result, the mantissa has a value between 1.0 and 2. If the exponent reaches -127 (binary 00000000), the leading 1.0 is no longer used to enable the gradual underflow.

The float_t type definition is as follows:

```plaintext
typedef float float_t;
```

The following figure shows the way in which the data is stored by this type:

Table 36. Data storage - normalized values

<table>
<thead>
<tr>
<th>Value</th>
<th>S</th>
<th>Exponent</th>
<th>Mantissa</th>
</tr>
</thead>
<tbody>
<tr>
<td>(2.0 - 2^{-23}) · 2^{127}</td>
<td>0</td>
<td>1 1 1 1 1 1 1 0</td>
<td>1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1</td>
</tr>
<tr>
<td>≈ 3.40282 · 10^{38}</td>
<td>7</td>
<td>F F F F F F F F</td>
<td></td>
</tr>
<tr>
<td>-(2.0 - 2^{-23}) · 2^{127}</td>
<td>1</td>
<td>1 1 1 1 1 1 1 1 0</td>
<td>1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1</td>
</tr>
<tr>
<td>≈ -3.40282 · 10^{38}</td>
<td>F</td>
<td>F F F F F F F F</td>
<td></td>
</tr>
<tr>
<td>2^{-126}</td>
<td>0</td>
<td>0 0 0 0 0 0 0 0 1</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ 1.17549 · 10^{-38}</td>
<td>8</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>-2^{-126}</td>
<td>1</td>
<td>0 0 0 0 0 0 0 0 1</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ -1.17549 · 10^{-38}</td>
<td>8</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>1.0</td>
<td>0</td>
<td>0 1 1 1 1 1 1 1</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>F F F F F F F F</td>
<td></td>
</tr>
<tr>
<td>-1.0</td>
<td>1</td>
<td>0 1 1 1 1 1 1 1</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>F F F F F F F F</td>
<td></td>
</tr>
<tr>
<td>π</td>
<td>0</td>
<td>1 0 0 0 0 0 0 0 0 0 0 1 0 0 1 0 0 0 0 0 1 1 1 1 1 0 1 1 0 1 1</td>
<td>4 0 4 9 0 F D B</td>
</tr>
<tr>
<td>≈ 3.1415927</td>
<td>3</td>
<td>F F F F F F F F</td>
<td></td>
</tr>
<tr>
<td>-20810.086</td>
<td>1</td>
<td>1 0 0 0 1 1 1 0 1</td>
<td>0 1 0 0 0 1 0 1 0 0 1 0 1 0 0 0 0 1 0 1 1 0 0</td>
</tr>
<tr>
<td></td>
<td>C</td>
<td>6 2 9 4 2 C</td>
<td></td>
</tr>
</tbody>
</table>

Table continues on the next page...
Table 36. Data storage - normalized values (continued)

Table 37. Data storage - denormalized values

<table>
<thead>
<tr>
<th>Value</th>
<th>31</th>
<th>24</th>
<th>23</th>
<th>16</th>
<th>15</th>
<th>8</th>
<th>7</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-0.0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>(1.0 - 2^{-23}) · 2^{-126}</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>11</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>≈ 1.17549 · 10^{-38}</td>
<td></td>
<td>0</td>
<td>0</td>
<td>7</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>-(1.0 - 2^{-23}) · 2^{-126}</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>11</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>≈ -1.17549 · 10^{-38}</td>
<td></td>
<td>8</td>
<td>0</td>
<td>7</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>2^{-1} · 2^{-126}</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>≈ 5.87747 · 10^{-39}</td>
<td></td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-2^{-1} · 2^{-126}</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>≈ -5.87747 · 10^{-39}</td>
<td></td>
<td>8</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2^{-23} · 2^{-126}</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>≈ 1.40130 · 10^{-45}</td>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>-2^{-23} · 2^{-126}</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>≈ -1.40130 · 10^{-45}</td>
<td></td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>
A.14 GMCLIB_3COOR_T_F16

The GMCLIB_3COOR_T_F16 structure type corresponds to the three-phase stationary coordinate system, based on the A, B, and C components. Each member is of the frac16_t data type. The structure definition is as follows:

```c
typedef struct
{
    frac16_t f16A;
    frac16_t f16B;
    frac16_t f16C;
} GMCLIB_3COOR_T_F16;
```

The structure description is as follows:

Table 39. GMCLIB_3COOR_T_F16 members description

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>frac16_t</td>
<td>f16A</td>
<td>A component; 16-bit fractional type</td>
</tr>
<tr>
<td>frac16_t</td>
<td>f16B</td>
<td>B component; 16-bit fractional type</td>
</tr>
<tr>
<td>frac16_t</td>
<td>f16C</td>
<td>C component; 16-bit fractional type</td>
</tr>
</tbody>
</table>

A.15 GMCLIB_3COOR_T_FLT

The GMCLIB_3COOR_T_FLT structure type corresponds to the three-phase stationary coordinate system, based on the A, B, and C components. Each member is of the float_t data type. The structure definition is as follows:

```c
typedef struct
{
    float_t fltA;
    float_t fltB;
} GMCLIB_3COOR_T_FLT;
```
The structure description is as follows:

Table 40. GMCLIB_3COOR_T_FLT members description

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>float_t</td>
<td>fltA</td>
<td>A component; 32-bit single precision floating-point type</td>
</tr>
<tr>
<td>float_t</td>
<td>fltB</td>
<td>B component; 32-bit single precision floating-point type</td>
</tr>
<tr>
<td>float_t</td>
<td>fltC</td>
<td>C component; 32-bit single precision floating-point type</td>
</tr>
</tbody>
</table>

A.16 GMCLIB_2COOR_AB_T_F16

The GMCLIB_2COOR_AB_T_F16 structure type corresponds to the general two-phase stationary coordinate system, based on the A and B orthogonal components. Each member is of the frac16_t data type. The structure definition is as follows:

```c
typedef struct
{
    frac16_t f16A;
    frac16_t f16B;
} GMCLIB_2COOR_AB_T_F16;
```

The structure description is as follows:

Table 41. GMCLIB_2COOR_AB_T_F16 members description

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>frac16_t</td>
<td>f16A</td>
<td>A-component; 16-bit fractional type</td>
</tr>
<tr>
<td>frac16_t</td>
<td>f16B</td>
<td>B-component; 16-bit fractional type</td>
</tr>
</tbody>
</table>

A.17 GMCLIB_2COOR_AB_T_F32

The GMCLIB_2COOR_AB_T_F32 structure type corresponds to the general two-phase stationary coordinate system, based on the A and B orthogonal components. Each member is of the frac32_t data type. The structure definition is as follows:

```c
typedef struct
{
    frac32_t f32Alpha;
    frac32_t f32Beta;
} GMCLIB_2COOR_AB_T_F32;
```

The structure description is as follows:

Table 42. GMCLIB_2COOR_AB_T_F32 members description

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>frac32_t</td>
<td>f32A</td>
<td>A component; 32-bit fractional type</td>
</tr>
<tr>
<td>frac32_t</td>
<td>f32B</td>
<td>B component; 32-bit fractional type</td>
</tr>
</tbody>
</table>
A.18 GMCLIB_2COOR_ALBE_T_F16

The GMCLIB_2COOR_ALBE_T_F16 structure type corresponds to the two-phase stationary coordinate system, based on the Alpha and Beta orthogonal components. Each member is of the frac16_t data type. The structure definition is as follows:

```c
typedef struct
{
    frac16_t f16Alpha;
    frac16_t f16Beta;
} GMCLIB_2COOR_ALBE_T_F16;
```

The structure description is as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>frac16_t</td>
<td>f16Apha</td>
<td>α-component; 16-bit fractional type</td>
</tr>
<tr>
<td>frac16_t</td>
<td>f16Beta</td>
<td>β-component; 16-bit fractional type</td>
</tr>
</tbody>
</table>

A.19 GMCLIB_2COOR_ALBE_T_FLT

The GMCLIB_2COOR_ALBE_T_FLT structure type corresponds to the two-phase stationary coordinate system based on the Alpha and Beta orthogonal components. Each member is of the float_t data type. The structure definition is as follows:

```c
typedef struct
{
    float_t fltAlpha;
    float_t fltBeta;
} GMCLIB_2COOR_ALBE_T_FLT;
```

The structure description is as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>float_t</td>
<td>fltApha</td>
<td>α-component; 32-bit single precision floating-point type</td>
</tr>
<tr>
<td>float_t</td>
<td>fltBeta</td>
<td>β-component; 32-bit single precision floating-point type</td>
</tr>
</tbody>
</table>

A.20 GMCLIB_2COOR_DQ_T_F16

The GMCLIB_2COOR_DQ_T_F16 structure type corresponds to the two-phase rotating coordinate system, based on the D and Q orthogonal components. Each member is of the frac16_t data type. The structure definition is as follows:

```c
typedef struct
{
    frac16_t f16D;
    frac16_t f16Q;
} GMCLIB_2COOR_DQ_T_F16;
```

The structure description is as follows:
Table 45. GMCLIB_2COOR_DQ_T_F16 members description

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>frac16_t</td>
<td>f16D</td>
<td>D-component; 16-bit fractional type</td>
</tr>
<tr>
<td>frac16_t</td>
<td>f16Q</td>
<td>Q-component; 16-bit fractional type</td>
</tr>
</tbody>
</table>

A.21 GMCLIB_2COOR_DQ_T_F32

The GMCLIB_2COOR_DQ_T_F32 structure type corresponds to the two-phase rotating coordinate system, based on the D and Q orthogonal components. Each member is of the frac32_t data type. The structure definition is as follows:

```c
typedef struct
{
    frac32_t f32D;
    frac32_t f32Q;
} GMCLIB_2COOR_DQ_T_F32;
```

The structure description is as follows:

Table 46. GMCLIB_2COOR_DQ_T_F32 members description

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>frac32_t</td>
<td>f32D</td>
<td>D-component; 32-bit fractional type</td>
</tr>
<tr>
<td>frac32_t</td>
<td>f32Q</td>
<td>Q-component; 32-bit fractional type</td>
</tr>
</tbody>
</table>

A.22 GMCLIB_2COOR_DQ_T_FLT

The GMCLIB_2COOR_DQ_T_FLT structure type corresponds to the two-phase rotating coordinate system, based on the D and Q orthogonal components. Each member is of the float_t data type. The structure definition is as follows:

```c
typedef struct
{
    float_t fltD;
    float_t fltQ;
} GMCLIB_2COOR_DQ_T_FLT;
```

The structure description is as follows:

Table 47. GMCLIB_2COOR_DQ_T_FLT members description

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>float_t</td>
<td>fltD</td>
<td>D-component; 32-bit single precision floating-point type</td>
</tr>
<tr>
<td>float_t</td>
<td>fltQ</td>
<td>Q-component; 32-bit single precision floating-point type</td>
</tr>
</tbody>
</table>

A.23 GMCLIB_2COOR_SINCOS_T_F16

The GMCLIB_2COOR_SINCOS_T_F16 structure type corresponds to the two-phase coordinate system, based on the Sin and Cos components of a certain angle. Each member is of the frac16_t data type. The structure definition is as follows:

```c
typedef struct
{
    frac16_t f16Sin;
    frac16_t f16Cos;
} GMCLIB_2COOR_SINCOS_T_F16;
```
```
frac16_t f16Cos;
} GMCLIB_2COOR_SINCOS_T_F16;
```

The structure description is as follows:

Table 48. GMCLIB_2COOR_SINCOS_T_F16 members description

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>frac16_t</td>
<td>f16Sin</td>
<td>Sin component; 16-bit fractional type</td>
</tr>
<tr>
<td>frac16_t</td>
<td>f16Cos</td>
<td>Cos component; 16-bit fractional type</td>
</tr>
</tbody>
</table>

A.24 GMCLIB_2COOR_SINCOS_T_FLT

The GMCLIB_2COOR_SINCOS_T_FLT structure type corresponds to the two-phase coordinate system, based on the Sin and Cos components of a certain angle. Each member is of the float_t data type. The structure definition is as follows:

```
typedef struct
{
    float_t fltSin;
    float_t fltCos;
} GMCLIB_2COOR_SINCOS_T_FLT;
```

The structure description is as follows:

Table 49. GMCLIB_2COOR_SINCOS_T_FLT members description

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>float_t</td>
<td>fltSin</td>
<td>Sin component; 32-bit single precision floating-point type</td>
</tr>
<tr>
<td>float_t</td>
<td>fltCos</td>
<td>Cos component; 32-bit single precision floating-point type</td>
</tr>
</tbody>
</table>

A.25 FALSE

The FALSE macro serves to write a correct value standing for the logical FALSE value of the bool_t type. Its definition is as follows:

```
#define FALSE    ((bool_t)0)
```

```
#include "mlib.h"
static bool_t bVal;
void main(void)
{
    bVal = FALSE; /* bVal = FALSE */
}
```
A.26  TRUE

The TRUE macro serves to write a correct value standing for the logical TRUE value of the bool_t type. Its definition is as follows:

```c
#define TRUE     ((bool_t)1)
```

```c
#include "mlib.h"
static bool_t bVal;
void main(void)
{
    bVal = TRUE;               /* bVal = TRUE */
}
```

A.27  FRAC8

The FRAC8 macro serves to convert a real number to the frac8_t type. Its definition is as follows:

```c
#define FRAC8(x) ((frac8_t)((x) < 0.9921875 ? ((x) >= -1 ? (x)*0x80 : 0x80) : 0x7F))
```

The input is multiplied by 128 (=2^7). The output is limited to the range <0x80 ; 0x7F>, which corresponds to <-1.0 ; 1.0-2^-7>.

```c
#include "mlib.h"
static frac8_t f8Val;
void main(void)
{
    f8Val = FRAC8(0.187);               /* f8Val = 0.187 */
}
```

A.28  FRAC16

The FRAC16 macro serves to convert a real number to the frac16_t type. Its definition is as follows:

```c
#define FRAC16(x) ((frac16_t)((x) < 0.999969482421875 ? ((x) >= -1 ? (x)*0x8000 : 0x8000) : 0x7FFF))
```

The input is multiplied by 32768 (=2^15). The output is limited to the range <0x8000 ; 0x7FFF>, which corresponds to <-1.0 ; 1.0-2^-15>.

```c
#include "mlib.h"
static frac16_t f16Val;
void main(void)
{
    f16Val = FRAC16(0.736);               /* f16Val = 0.736 */
}
```
A.29  FRAC32

The FRAC32 macro serves to convert a real number to the frac32_t type. Its definition is as follows:

```c
#define FRAC32(x) ((frac32_t)((x) < 1 ? ((x) >= -1 ? (x)*0x80000000 : 0x80000000) : 0x7FFFFFFF))
```

The input is multiplied by 2147483648 (=2^{31}). The output is limited to the range <0x80000000 ; 0x7FFFFFFF>, which corresponds to <-1.0 ; 1.0-2^{-31}>.

```c
#include "mlib.h"
static frac32_t f32Val;
void main(void)
{
    f32Val = FRAC32(-0.1735667);               /* f32Val = -0.1735667 */
}
```

A.30  ACC16

The ACC16 macro serves to convert a real number to the acc16_t type. Its definition is as follows:

```c
#define ACC16(x) ((acc16_t)((x) < 255.9921875 ? ((x) >= -256 ? (x)*0x80 : 0x8000) : 0x7FFF))
```

The input is multiplied by 128 (=2^7). The output is limited to the range <0x8000 ; 0x7FFF> that corresponds to <-256.0 ; 255.9921875>.

```c
#include "mlib.h"
static acc16_t a16Val;
void main(void)
{
    a16Val = ACC16(19.45627);               /* a16Val = 19.45627 */
}
```

A.31  ACC32

The ACC32 macro serves to convert a real number to the acc32_t type. Its definition is as follows:

```c
#define ACC32(x) ((acc32_t)((x) < 65535.999969482421875 ? ((x) >= -65536 ? (x)*0x8000 : 0x80000000) : 0x7FFFFFFF))
```

The input is multiplied by 32768 (=2^{15}). The output is limited to the range <0x80000000 ; 0x7FFFFFFF>, which corresponds to <-65536.0 ; 65536.0-2^{-15}>.

```c
#include "mlib.h"
static acc32_t a32Val;
void main(void)
```
```c
{  
a32Val = ACC32(-13.654437);  /* a32Val = -13.654437 */
}
```
Limited warranty and liability — Information in this document is provided solely to enable system and software implementers to use NXP products. There are no express or implied copyright licenses granted hereunder to design or fabricate any integrated circuits based on the information in this document. NXP reserves the right to make changes without further notice to any products herein.

NXP makes no warranty, representation, or guarantee regarding the suitability of its products for any particular purpose, nor does NXP assume any liability arising out of the application or use of any product or circuit, and specifically disclaims any and all liability, including without limitation consequential or incidental damages. “Typical” parameters that may be provided in NXP data sheets and/or specifications can and do vary in different applications, and actual performance may vary over time. All operating parameters, including “typicals,” must be validated for each customer application by customer’s technical experts. NXP does not convey any license under its patent rights nor the rights of others. NXP sells products pursuant to standard terms and conditions of sale, which can be found at the following address: nxp.com/SalesTermsandConditions.

Right to make changes - NXP Semiconductors reserves the right to make changes to information published in this document, including without limitation specifications and product descriptions, at any time and without notice. This document supersedes and replaces all information supplied prior to the publication hereof.

Security — Customer understands that all NXP products may be subject to unidentified or documented vulnerabilities. Customer is responsible for the design and operation of its applications and products throughout their lifecycles to reduce the effect of these vulnerabilities on customer’s applications and products. Customer’s responsibility also extends to other open and/or proprietary technologies supported by NXP products for use in customer’s applications. NXP accepts no liability for any vulnerability. Customer should regularly check security updates from NXP and follow up appropriately. Customer shall select products with security features that best meet rules, regulations, and standards of the intended application and make the ultimate design decisions regarding its products, regardless of any information or support that may be provided by NXP. NXP has a Product Security Incident Response Team (PSIRT) (reachable at PSIRT@nxp.com) that manages the investigation, reporting, and solution release to security vulnerabilities of NXP products.

NXP, the NXP logo, NXP SECURE CONNECTIONS FOR A SMARTER WORLD, COOLFLUX, EMBRACE, GREENCHIP, HITAG, ICODE, JCOP, LIFE, VIBES, MIFARE, MIFARE CLASSIC, MIFARE DESFire, MIFARE PLUS, MIFARE FLEX, MANTIS, MIFARE ULTRALIGHT, MIFARE4MOBILE, MIGLO, NTAG, ROADLINK, SMARTLX, SMARTMX, STARPLUG, TOPFET, TRENCHMOS, UCODE, Freescale, the Freescale logo, Altivec, CodeWarrior, ColdFire, ColdFire+, the Energy Efficient Solutions logo, Kinetis, Layerscape, MagniV, mobileGT, PEG, PowerQUICC, Processor Expert, QorIQ, QorIQ Qonverge, SafeAssure, the SafeAssure logo, StarCore, Symphony, VortiQa, Vybrid, Airfast, BeeKit, BeeStack, CoreNet, Flexis, MXC, Platform in a Package, QUICC Engine, Tower, TurboLink, EdgeScale, EdgeLock, eliQ, and Immersive3D are trademarks of NXP B.V. All other product or service names are the property of their respective owners. AMBA, Arm, Arm7, Arm7TDMI, Arm9, Arm11, Artisan, big.LITTLE, Cordic, CoreLink, CoreSight, Cortex, DesignStart, DynamIQ, Jazelle, Keil, Mali, Mbed, Mbed Enabled, NEON, POP, RealView, SecurCore, Socrates, Thumb, TrustZone, ULINK, ULINK2, ULINK-ME, ULINK-PLUS, ULINKpro, μVision, Versatile are trademarks or registered trademarks of Arm Limited (or its subsidiaries) in the US and/or elsewhere. The related technology may be protected by any or all of patents, copyrights, designs and trade secrets. All rights reserved. Oracle and Java are registered trademarks of Oracle and/or its affiliates. The Power Architecture and Power.org word marks and the Power and Power.org logos and related marks are trademarks and service marks licensed by Power.org. M, M Mobileye and other Mobileye trademarks or logos appearing herein are trademarks of Mobileye Vision Technologies Ltd. in the United States, the EU and/or other jurisdictions.